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About This Document

The SPA9000 Voice System Installation and Configuration Guide for Web UI is 
intended to help VARs and Service Providers to manage and configure the 
SPA9000 Voice System. This preface provides helpful information about this guide 
and other resources that are available to you. Before you begin to use this guide, 
refer to the following topics:

• “Purpose,” on page vi

• “Audience,” on page vii

• “Firmware,” on page vii

• “Organization,” on page viii

• “Document Conventions,” on page ix

• “Finding Information in PDF Files,” on page x

Purpose

This document provides information that an administrator needs to configure the 
SPA9000 Voice System, which typically consists of a SPA9000 IP PBX, one or 
more SPA900 Series IP phones, and the optional SPA400 PSTN gateway and 
voice mail server. This guide focuses primarily on the tasks that an administrator 
performs to configure a SPA9000 with the SPA9000 administration web server.

NOTE This guide does not cover initial installation and configuration, SPA900 Series 
phone configuration, the Setup Wizard, or provisioning. See “Related 
Documentation,” on page156.
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Audience

This document is written for the following audience:

• Service providers who offer services using the SPA9000 Voice System

• VARs and resellers who need configuration references for the SPA9000 Voice 
System

• System administrators or anyone who installs and manages the SPA9000 
Voice System

NOTE This guide does not provide the configuration information required by specific 
service providers. Please consult with the service provider for specific service 
parameters.

Firmware

This guide describes the features that are available in the following firmware 
releases. 

Product Firmware Version

SPA9000 6.1.5

SPA400 1.1.2.2

SPA901 5.1.5

SPA921/SPA941 5.1.8

SPA922/942 6.1.3

SPA962 6.1.3

WIP310 5.0.8
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Organization

The information in this guide is organized into the following chapters and 
appendices:

Chapter Description

Chapter 1, “Getting Started” This chapter introduces you to the SPA9000 
Voice System by describing the components 
and presenting several deployment scenarios.

Chapter 2, “Installation and 
Configuration Process 
Overview”

This chapter provides an overview of the 
installation and configuration process.

Chapter 3, “Preparation” This chapter is essential reading before you 
begin installing the equipment or configuring the 
system. To ensure that the installation process 
goes smoothly, verify that you have the required 
services, equipment, and information.

Chapter 4, “Connecting the 
Equipment”

This chapter explains how to connect your 
equipment and upgrade the firmware. At the end 
of each section, you verify that the installation is 
progressing correctly.

Chapter 5, “Configuring 
Phone Service and Voice 
Mail”

This chapter guides you through the basic tasks 
that are required to get your voice system 
running. After you complete these procedures, 
users will be able to place and receive calls from 
the ITSP and from the PSTN. Callers will be able 
to leave voice mail, and users will be able to 
retrieve it.

Chapter 6, “Configuring 
Special Features”

This chapter helps you to get started setting up 
various features that may be useful to your 
customer.

Chapter 7, “Localization” This chapter explains how to localize your 
SPA9000 Voice System with the language files, 
tones, and ring patterns for your region.
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Document Conventions

The following table describes the typographic conventions that are used in this 
document.

Appendix A, “Installation 
Workbook”

This workbook is intended to help you to record 
information about the customer’s network 
environment as well as the order and service 
information, before installing the SPA9000 Voice 
System. By using this workbook, you can 
minimize the installation time and ensure that all 
setup requirements are met.

Appendix B, 
“Troubleshooting”

This appendix provides solutions to problems 
that may occur during the installation and 
operation of the SPA9000 Voice System. If you 
can’t find an answer here, visit www.cisco.com/
web/partners/sell/smb/.

Appendix C, “Where to Go 
From Here”

Appendix D, “Additional 
Information”

Appendix E, “Support 
Contacts”

These appendices provide links to other 
resources tha may be helpful to you.

Chapter Description

Typographic 
Element

Meaning

Boldface May indicate either of the following:

• A user interface element that you need to click, select, or 
otherwise act on

• A literal value to be entered in a field. 

Italic May indicate either of the following:

• A variable that should be replaced with a literal value.

• The name of a page, section, or field in the user interface

Monospaced 
Font

Indicates code samples or system output.
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Finding Information in PDF Files
The SPA9000 Voice System documents are published as PDF files. The PDF Find/
Search tool within Adobe® Reader® lets you find information quickly and easily 
online. You can perform the following tasks:

• Search an individual PDF file.

• Search multiple PDF files at once (for example, all PDFs in a specific folder or 
disk drive).

• Perform advanced searches.

Finding Text in a PDF

Follow this procedure to find text in a PDF file.

STEP 1 Enter your search terms in the Find text box on the toolbar. 

NOTE By default, the Find tool is available at the right end of the Acrobat toolbar. If 
the Find tool does not appear, choose Edit > Find.

 

STEP 2 Optionally, click the arrow next to the Find text box to refine your search by 
choosing special options such as Whole Words Only. 

STEP 3 Press Enter. 

STEP 4 Acrobat displays the first instance of the search term. 

STEP 5 Press Enter again to continue to more instances of the term.
SPA9000 Voice System Installation and Configuration Guide for Web UI x
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Finding Text in Multiple PDF Files

The Search window lets you search for terms in multiple PDF files that are stored 
on your PC or local network. The PDF files do not need to be open. 

STEP 1 Start Acrobat Professional or Adobe Reader. 

STEP 2 Choose Edit > Search, or click the arrow next to the Find box and then choose 
Open Full Acrobat Search. 

STEP 3 In the Search window, complete the following steps:

a. Enter the text that you want to find.

b. Choose All PDF Documents in.

From the drop-down box, choose Browse for Location. Then choose the 
location on your computer or local network, and click OK. 

c. If you want to specify additional search criteria, click Use Advanced Search 
Options, and choose the options you want. 

d. Click Search. 
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Preface
 

STEP 4 When the Results appear, click + to open a folder, and then click any link to open 
the file where the search terms appear.

For more information about the Find and Search functions, see the Adobe Acrobat 
online help.
SPA9000 Voice System Installation and Configuration Guide for Web UI xii
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Getting Started

This chapter introduces you to the SPA9000 Voice System by describing the 
components and presenting several deployment scenarios.

NOTE This chapter is essential reading before you begin installing the equipment or 
configuring the system. 

• “Introduction to the SPA9000 Voice System,” on page13

• “Deployment Scenarios,” on page15

• “Introducing Components of the SPA9000 Voice System,” on page 20

Introduction to the SPA9000 Voice System

The SPA9000 Voice System is an affordable and feature-rich IP telephone system 
that is designed especially for the Small and Home Office. The SPA9000 Voice 
System uses standard TCP/IP protocols and can provide global connectivity 
through any Internet Telephony Service Provider (ITSP) that supports the Session 
Initiation Protocol (SIP). 

At minimum, the SPA9000 Voice System includes a SPA9000 IP PBX and one or 
more SPA900 series IP phones. These devices are connected through a switch to 
a local area network. With an Internet connection, the SPA9000 Voice System can 
subscribe to ITSP services to take advantage of low calling rates. With the 
SPA400, the SPA9000 Voice System can connect to the Public Switched 
Telephone Network (PSTN) to support analog phone lines. See Figure 1 “SPA9000 
Voice System with the SPA9000 and SPA400” on page14 to learn more about a 
typical deployment.
SPA9000 Voice System Installation and Configuration Guide for Web UI 13
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Figure 1 SPA9000 Voice System with the SPA9000 and SPA400

SPA9000 IP PBX

The SPA9000 is an IP PBX that supports up to 16 phones. It also has a built-in 
Analog Telephone Adapter (ATA) with two FXS ports for analog telephones, fax 
devices, or an external music source for the music on-hold service. Devices 
connected to the FXS ports are not included in the device count.

The SPA9000 has four line interfaces, which can be configured in any combination 
for ITSP service, ISDN access, SPA400 PSTN access, or SPA400 voice mail 
service. A different ITSP account can be configured on each line interface. If a 
service provider supplies a group of sequential direct inward dial (DID) phone 
numbers (such as 408-555-0100 through 555-0145) the SPA9000 can support all 
of the assigned numbers on a single line interface. 

SPA9xx IP Phones

SLM224P Switch SPA9000 IP PBX

WRV200 Router

Internet

Integrated 
Access Device

Analog 
Phone Lines

SPA400
 for Voice Mail

SPA400
 for PSTN Access

Analog Phones
or Fax Machines

WIP310
Wireless-G 

IP Phone
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The SPA9000 includes an Auto Attendant service that plays pre-recorded voice 
messages to offer the caller a menu of choices and to direct the call. When the 
Auto-Attendant is enabled, it parses and operates on user key presses according 
to the rules that are specified in the Auto Attendant script. 

SPA400 SIP-PSTN Gateway and Voicemail Server

The SPA400 provides a SIP-PSTN gateway for voice connectivity between the 
PSTN and the local client stations that are connected to the SPA9000. It also 
includes an integrated voice mail application that supports up to 32 voice mail 
accounts with customized greetings, providing the ability to receive and playback 
voice mail messages. 

Each SPA400 occupies one of the four line interfaces on the SPA9000. The 
SPA400 has four ports for that can be connected to PSTN or ISDN lines. 

IP Phones and Accessories

The SPA9000 Voice System supports any of the Cisco SPA900 Series SIP IP 
Phones, as well as the Cisco WIP310 Wireless IP Phone. 

NOTE This guide explains how to configure the SPA9000 and the SPA400 to support the 
calling features on the phones. For more information about the phones, see the 
SPA9x2 Phone Administration Guide, the SPA9x2 Phone User Guide, and the 
Cisco Wireless-G IP Phone User Guide.

Deployment Scenarios

The SPA9000 Voice System can meet the calling needs of many small businesses. 
Various deployment scenarios are possible. This section includes the following 
examples:

• “PSTN Access and Local Voice Mail,” on page16

• “ITSP Service Only,” on page17

• “ITSP Service, PSTN Access and Local Voice Mail,” on page18

• “ITSP Service, PSTN and ISDN Access and Local Voice Mail,” on page19
SPA9000 Voice System Installation and Configuration Guide for Web UI 15
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PSTN Access and Local Voice Mail

In this scenario, the customer requires a robust phone system but is not using VoIP 
services. The SPA9000 Voice System is deployed with a SPA9000 IP PBX, one 
SPA400 for PSTN access with four FXO ports, and another SPA400 for local voice 
mail service. Up to 16 IP phones can be installaed. Optionally, analog phones or fax 
machines (not illustrated) can be connected to the two phone ports on the 
SPA9000.

SLM224P Switch SPA9000 IP PBX

Analog 
Phone Lines

SPA400
 for Voice Mail

SPA400
 for PSTN Access

Up to 16 IP Phones
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ITSP Service Only

In this scenario, a customer has no legacy telephone numbers and either needs no 
voice mail at all or has voice mail hosted by the ITSP. The SPA9000 Voice System 
is deployed with the SPA9000 IP PB and VoIP service. Up to 16 IP phones can be 
installaed. Optionally, analog phones or fax machines (not illustrated) can be 
connected to the two phone ports on the SPA9000. 

SLM224P Switch
SPA9000 IP PBX

WRV200 Router

Internet

Integrated 
Access Device

Up to 16 IP Phones
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ITSP Service, PSTN Access and Local Voice Mail

In this scenario, the customer wants to use ITSP service for reduced long distance 
fees but needs to support legacy local telephone numbers (for example, to receive 
calls to a legacy telephone number or to place outbound calls in the local area). 
This customer also prefers local voice mail service. The SPA9000 Voice System is 
deployed with the SPA9000 IP PBX, VoIP service, one SPA400 unit for voice mail 
service, and another SPA400 unit for PSTN access with four FXO ports. Up to 16 IP 
phones can be installaed. Optionally, analog phones or fax machines (not 
illustrated) can be connected to the two phone ports on the SPA9000. 

SLM224P Switch SPA9000 IP PBX

WRV200 Router

Internet

Integrated 
Access Device

Analog 
Phone Lines

SPA400
 for Voice Mail

SPA400
 for PSTN Access

Up to 16 IP Phones
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ITSP Service, PSTN and ISDN Access and Local Voice Mail

In this scenario, the customer takes full advantage of the SPA9000 Voice System 
solution. This customer has the SPA9000 IP PBX, VoIP service, one SPA400 unit for 
voice mail service, and another SPA400 for PSTN access with four FXO ports. In 
addition, this installation includes an ISDN Gateway for ISDN BRI access with four 
BRI ports. Up to 16 IP phones can be installaed. Optionally, analog phones or fax 
machines (not illustrated) can be connected to the two phone ports on the 
SPA9000. 

SLM224P Switch SPA9000 IP PBX

WRV200 Router

Internet

Integrated
Access Device

Analog 
Phone Lines

SPA400
 for Voice Mail

SPA400
 for PSTN Access

Mediatrix® 4402 
BRI Gateway

ISDN
Phone Lines

Up to 16 IP Phones
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Introducing Components of the SPA9000 Voice System

This section describes the features of the components of the SPA9000 Voice 
System, including the SPA9000, the SPA400, and the various models of SPA9xx 
phones.

• “Getting to Know Your SPA9000,” on page 20

• “Getting to Know Your SPA400,” on page 22

• “Getting to Know Your IP Phones and Accessories,” on page 24

• “Getting to Know Your WRV200 Router,” on page 26

• “Getting to Know the SLM224P Switch,” on page 28

Getting to Know Your SPA9000 

The SPA9000 is an IP PBX system with high-end features comparable to 
traditional large business voice services. This section describes the LEDs on the 
front panel and the ports on the back panel of the device.

SPA9000 Front Panel

LED Description/Notes

Power • Green: The device is receiving power and is connected 
to the Internet.

• Flashing Green: The device is receiving power but is not 
connected to the Internet.

• Unlit: The device is not receiving power.
SPA9000 Voice System Installation and Configuration Guide for Web UI 20
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SPA9000 Back Panel

Internet • Green: The device is connected to the Internet.

• Flashing Green: The device is experiencing network 
activity.

• Unlit: The device is not connected to the Internet.

Phone 1, Phone 2 • Green: The phone is on hook and is registered with an 
active Internet phone service account.

• Unlit: The phone is on hook but is not registered with an 
active Internet phone service account.

• Flashing Green: The phone is off hook.

Port Description/Notes

Phone 1, Phone 2 Use these ports to connect analog phones or fax 
machines to your IP phone account.

Ethernet Use this port to connect a computer for administration 
of the SPA9000.

Internet Use this port to connect the SPA9000 to the Local Area 
Network (LAN). The cable may be connected to a 
switch, router or Integrated Access Device.

Power Use this port to connect to the external Power adapter 
(PA100).

LED Description/Notes
SPA9000 Voice System Installation and Configuration Guide for Web UI 21
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Getting to Know Your SPA400 

The SPA400 provides the SPA9000 access to the PSTN by connecting the FXO 
ports to analog lines. The SPA400 also has a built-in voice mail server. 

This section describes the LEDs on the front panel and the ports on the back panel 
of the device.

SPA400 Front Panel

LED Description/Notes

Power • Steady green: The SPA400 is receiving power and is 
connected to the Internet.

• Flashing: The SPA400 is not connected to the Internet, 
booting, or upgrading firmware.

Status • Steady green: The SPA9000 is registered to the SPA400.

• Flashing: The SPA9000 is not registered to the SPA400.

Ethernet • Steady green: The SPA400 has an active connection 
through the Ethernet port.

• Flashing: Network activity is occurring over the Ethernet 
port.

Line 1, 2, 3, 4 • Steady green: The line is active.

• Flashing: The line is ringing.

• Off: The line is idle.

USB • Steady green: The USB voice mail module is registered.

• Off: No module is detected.
SPA9000 Voice System Installation and Configuration Guide for Web UI 22
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SPA400 Back Panel

Port Description/Notes

USB Use this port for the USB voice mail module, which 
contains the voice mail prompts and provides the 
storage location for saving voice mailbox messages.

Ethernet Use this port to connect to the Local Area Network 
(LAN) for communications with SPA9000.

Line 1, 2, 3, 4 These FXO ports are used to connect to an analog 
phone lines.

Reset This button is used to reset the device.

Power Use this port to connect to the external Power adapter 
(PA100).
SPA9000 Voice System Installation and Configuration Guide for Web UI 23
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Getting to Know Your IP Phones and Accessories

Cisco provides a variety of phone models to suit the needs of small businesses. 
The following table provides a comparison of Cisco IP phones and accessories 
that can be used with the SPA9000 Voice System.

Product RJ-45 Voice 
Lines

Additional 
Features/Notes

SPA922* 2 1 One-line IP phone 
with Power over 
Ethernet (PoE) 
support

SPA942* 2 4 Four-line IP phone 
with Power over 
Ethernet (PoE) 
support

SPA962* 2 6 Six-line IP Phone 
with high-resolution 
color display and 
Power over Ethernet 
(PoE) support

WIP310 N/A 1 Wireless-G IP phone
SPA9000 Voice System Installation and Configuration Guide for Web UI 24
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NOTE * SPA922/942/962 do not include an external power adapter. If you are using a non-
PoE switch, a PA100 power adapter is required.

SPA932 — — Attendant console 
(sidecar) for SPA962 
with 32 buttons and 
LEDs for monitoring 
and call transfer

POES5 1 N/A Provides an 802.3af 
PoE port for 
connection back to a 
PoE switch for 
SPA9000 and 
SPA400

WBP54G 1 N/A Converts your IP 
phone into a wireless 
device, so it can 
connect to your 
wireless network 
without an Ethernet 
cable

Product RJ-45 Voice 
Lines

Additional 
Features/Notes
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Getting to Know Your WRV200 Router

WRV200 is a VPN router with a Wireless-G access point for small offices and 
home offices. It is strongly recommended for use with the SPA9000 Voice System. 

NOTE A Wireless-G router is required if you are using wireless components such as the 
WIP310 telephone.

WRV200 Front Panel 

LED/Port Description

Power • Green: The router is receiving power. 

• Flashing Green: The router is running a diagnostic test.

DMZ • Green: The router has an available DMZ port.

• Flashing Green: The router is sending or receiving data 
over the DMZ port.

Internet • Green: The router is connected to a Broadband Access 
device at the indicated speed (10, 100, 1000).

• Flashing Green: The router is transmitting or receiving 
data over the Internet port.
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WRV200 Back Panel

Wireless • Green: The router has a successful wireless connection. 

• Flashing Green: The Router is actively sending or 
receiving data over the wireless network.

1-4 (Ethernet) These four LEDs correspond to the router’s four 
Ethernet ports. 

• Green: The Router is connected to a device through the 
corresponding port (1, 2, 3, or 4). 

• Flashing Green: The Router is actively sending or 
receiving data over the corresponding port.

LED/Port Description
SPA9000 Voice System Installation and Configuration Guide for Web UI 27
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Getting to Know the SLM224P Switch

The SLM224P switch has 24 10/100 Copper ports with two shared Gigabit 
copper or optical SFP ports (combo ports) for connecting the switch to the core 
network.

NOTE In this guide, the SLM224P switch is used in all examples and illustrations. However, 
various Cisco switches can be used with the SPA9000 Voice System. Cisco 
recommends use of SLMxxxP, SRWxxxP and SRWxxxMP switch product families 
with the SPA9000 Voice System.

LED/Port Description

Power The port is used to connect the router to AC power, 
using the provided power cable.

Reset • The Reset button has two functions:

• If the Router is having problems connecting to the 
Internet, press the Reset button for just a second with a 
paper clip or a pencil tip. This is similar to pressing the 
Reset button on your PC to reboot it.

• If you are experiencing extreme problems with the 
router and have tried all other troubleshooting measures, 
press and hold in the Reset button for 10 seconds. This 
action restores the factory defaults and clears all of the 
Router’s settings, such as port forwarding or a new 
password.

Internet Use this port to connect the router to a Broadband 
Access device.

1-4 (Ethernet) Use these ports to connect the router to network 
devices, such as PCs, print servers, or additional 
switches.
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SLM224P Front Panel

LED/Port Description

System • Green: Power is being supplied to the switch.

• Solid Amber: The switch is performing the Power-On 
Self Test (POST).

Link/Act (1-24) • Green: The switch has a functional 10/100 Mbps 
network link through the corresponding port with an 
attached device. 

• Flashing: The switch is actively sending or receiving data 
over the corresponding port.

PoE (1-6, 13-18) • Flashing Amber: Power is being supplied to an attached 
powered device (PD) on the corresponding port (1 
through 6, 13 through 18). 

100M (7-12, 19-24) • Amber: The switch has a functional 100 Mbps 
connection on the corresponding port (7 through 12, 19 
through 24) with an attached device.

Link/Act (G1-G2) • Green: Lights up to indicate a functional 10/100/1000 
Mbps network link through the corresponding port (G1 
through G2) with an attached device. 

• Flashing Green: The switch is actively sending or 
receiving data over the corresponding port.

Gigabit (G1-G2) • Amber: The switch has a functional 1000 Mbps 
connection on the corresponding port with an attached 
device.

Reset • To reboot the switch, press and hold the Reset button for 
approximately five seconds. 

• To reset the Switch settings to the factory defaults, 
press and hold the Reset Button for approximately ten 
seconds.
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SLM224P Back Panel

The back panel has one port, the Power port, which is used to connect the power 
cord.

Ethernet (1-24) The Switch is equipped with 24 auto-sensing, Ethernet 
network ports, which use RJ-45 connectors. The Fast 
Ethernet ports support network speeds of 10 Mbps, 
100 Mbps, or 1000 Mbps. They can operate in half- 
and full-duplex modes. Auto-sensing technology 
enables each port to automatically detect the speed of 
the device connected to it (10 Mbps, 100 Mbps, or 
1000 Mbps), and adjust its speed and duplex 
accordingly.

G1-G2 The switch is equipped with 2 auto-sensing 10 Mbps, 
100 Mbps, or 1000 Mbps Gigabit Ethernet network 
ports, which use RJ-45 connectors. They can operate 
in half- and full-duplex modes. 

mini-GBIC (1-2) The mini-GBIC (gigabit interface converter) port is a 
connection point for a mini-GBIC expansion module, so 
the switch can be uplinked via fiber to another switch. 

LED/Port Description
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Installation and Configuration Process 
Overview

This chapter provides an overview of the installation and configuration process. 

A. Preparation

In Chapter 3, “Preparation,” you learn about the equipment and service 
requirements, bandwidth requirements, call capacity, and related topics , to ensure 
that the system is well designed to meet the needs of the customer. This chapter 
also describes basic procedures such as downloading firmware, which should be 
completed before you begin installing the equipment.

B. Connecting the Equipment

In this phase, you physically connect the SPA9000 Voice System equipment to the 
LAN. Chapter 4, “Connecting the Equipment” explains how to connect the 
SPA9000, which provides the PBX service for the phones, and the SPA400, which 
provides voice mail service and PSTN access. You also learn how to install the IP 
phones and any accessories such as PoE adapters and wall-mount brackets. You 
also upgrade the firmware with the new files that you downloaded during the 
Preparation phase. 

C. Configuring Voice Services

After you connect the equipment, you need to configure voice features such as 
ITSP service, PSTN access, and voice mail service.Chapter 5, “Configuring 
Phone Service and Voice Mail” guides you through these steps. You also set up 
call routing for outbound and inbound calls.
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D. Configuring Advanced Features

Now you are ready to begin configuring advanced features, depending on the 
business needs. In Chapter 6, “Configuring Special Features,” you learn how to 
configure Music On Hold, to set up the SPA962 phone with the SPA932 attendant 
console, and to route calls with hunt groups and shared line appearances.

E. Localizing the System

For customers outside North America, you need to localize the system. Chapter 7, 
“Localization,” guides you through the steps.
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Preparation

This chapter is essential reading before you begin installing the equipment or 
configuring the system. To ensure that the installation process goes smoothly, 
verify that you have the required services, equipment, and information. 

Refer to the following topics:

• “Site Survey,” on page 33

• “System Design Considerations,” on page 34

• “Network Setup Review,” on page 36

• “Quality of Service,” on page 38

• “Local Area Network Design,” on page 38

• “Services and Equipment,” on page 39

Site Survey

The site surveys consists of gathering relevant information about the customer, the 
existing infrastructure, the network, the telephone equipment, and the available 
services. This survey helps you to prepare for the installation of the SPA9000 
Voice System (for example, ordering the Cisco SPA devices from the distribution 
channel) and to anticipate the design considerations. The site survey can be 
conducted on the customer premises or remotely over the phone and email.

Various site survey templates can be used. Appendix A, “Installation Workbook,” 
contains a site survey template example that you can use to record the customer 
information.
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System Design Considerations

When installing and configuring the SPA9000 Voice System, it is necessary to 
analyze and meet some design considerations to ensure the best quality and user 
experience. The design considerations cover available bandwidth and quality of 
service.

Bandwidth Requirements and Call Capacity

The available connection bandwidth determines the maximum number of 
simultaneous calls that the system can support with the appropriate audio quality. 
Before installing and configuring the Cisco SPA devices, use this information to 
determine the maximum number of simultaneous VoIP connections that the 
system can support. For asymmetric connections, such as ADSL, the maximum 
number of calls is determined by the upstream bandwidth. In general it is a good 
practice to use no more than 75% of the total available bandwidth for calls. This 
provides space for data traffic and helps ensure good voice quality.

NOTE Some ITSP SIP trunk services limit the maximum number of simultaneous calls. 
Please check with your Service Provider to understand the maximum number of 
simultaneous calls each SIP trunk supports.

The following table provides the approximate bandwidth budget for different 
codecs. 

Codec Approximate bandwidth 
budget for each side of 
conversation

2 calls 4 calls 6 calls 8 calls

G.711 110 kbps 220 
kbps

440 
kbps

660 
kbps

880 
kbps

G.726-
40

87 kbps 174 
kbps

348 
kbps

522 
kbps

696 
kbps

G.726-
32

79 kbps 158 
kbps

316 
kbps

474 
kbps

632 
kbps

G.726-
24

71 kbps 142 
kbps

284 
kbps

426 
kbps

568 
kbps
SPA9000 Voice System Installation and Configuration Guide for Web UI 34



Preparation
System Design Considerations 3

 

For more information about bandwidth calculation, refer to the following web sites:

www.erlang.com/calculator/lipb/

www.bandcalc.com/

Wide Area Network (WAN) Quality of Service

You can choose from several types of broadband access technologies to provide 
symmetric or asymmetric connectivity to a small business. These technologies 
vary on the available bandwidth and on the quality of service. It is generally 
recommended that you use broadband access with a Service Level Agreement 
that provides quality of service. If there is not a Service Level Agreement with 
regard to the broadband connection quality of service, the downstream audio 
quality may be affected negatively under heavy load conditions (bandwidth 
utilization beyond 80%). 

To eliminate or minimize this effect, Cisco recommends one of the following 
actions:

• For broadband connections with a bandwidth lower than 2 Mbps, perform the 
call capacity calculations by assuming a bandwidth value of 50% of the 
existing broadband bandwidth. For example, in the case of a 2 Mbps uplink 
broadband connection, assume 1 Mbps. Limit the uplink bandwidth in the 
Integrated Access Device to this value. This setting helps to maintain the 
utilization levels below 60%, thus reducing jitter and packet loss.

• Use an additional broadband connection for voice services only. A separate 
connection is required when the broadband connection services do not offer 
quality of service and when it is not possible to apply the above mentioned 
utilization mechanism.

G.726-
16

63 kbps 126 
kbps

252 
kbps

378 
kbps

504 
kbps

G.729 55 kbps 110 
kbps

220 
kbps

330 
kbps

440 
kbps

Codec Approximate bandwidth 
budget for each side of 
conversation

2 calls 4 calls 6 calls 8 calls
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Network Setup Review

The Local Area Network (LAN) is the communication platform used by the 
SPA9000 Voice System for allowing communications among the telephone users 
and between the telephone users and the external VoIP, PSTN or/and ISDN 
network services. This LAN is composed of the data wiring (UTP cabling), 
networking equipment (switches and routers/access device) and the 
telecommunication (PSTN or ISDN) lines.

The Local Area Network (LAN) may be already installed or it can be installed and 
configured at the time of installing the SPA9000 Voice System. Below are the 
general recommendations to ensure proper operation of the SPA9000 Voice 
System.

Infrastructure, Cabling and PSTN/ISDN Lines

• AC outlets: Ensure there is an AC outlet available for every LAN and Cisco SPA 
component that requires AC power. If you are using a Power over Ethernet 
switch, SPA9x2 phones do not require an AC outlet as they are powered by the 
switch.

• Ethernet cabling: Ensure there is a Ethernet cabling system and that there is an 
outlet for each Cisco SPA device. It is recommended that Ethernet cables are 
UTP CAT 5e or better.

• PSTN and ISDN lines: Ensure that the lines are operative and that any features, 
such as caller identification, operate properly before starting the installation. 
Ensure that the cables are available in the location where you are installing the 
Cisco SPA devices.

• UPS: If you are using an Uninterrupted Power Supply (UPS) mechanism, ensure 
that the SPA9000 Voice System design is covered by securing the router and 
switch AC connections and the Cisco SPA devices and by using the Power 
over Ethernet adapter (POES5) for the non-POE products (SPA9000, SPA400, 
SPA9x1 phones). Also ensure that devices such as the WAN modem, CSU/
DSU, or DDS modem are connected to the UPS.
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NAT Mapping

Network Address Translation (NAT) is a function that allows multiple devices to 
share the same public, routable, IP address to establish connections over the 
Internet. NAT is present in many broadband access devices to translate public and 
private IP addresses. To enable VoIP to co-exist with NAT, some form of NAT 
traversal is required. 

Some ITSPs provide NAT traversal, but some do not. If your ITSP does not provide 
NAT traversal, you have several options.

• NAT mapping with SIP-ALG router: Use a router such as the WRV200, which 
has a SIP ALG (Application Layer Gateway). With a SIP ALG in the router, you 
have more choices in selecting an ITSP.

• ITSP that supports NAT mapping through a Session Border Controller: With 
NAT mapping provided by the ITSP, you have more choices in selecting a 
router.

• NAT mapping with the SPA9000 EXT IP setting: Configuring NAT mapping in 
the SPA9000 is recommended only if the ITSP network does not provide a 
Session Border Controller functionality. If this is the case, and if the external 
(public) IP address is static, then Cisco recommends mapping a static 
(permanent) IP address on the SPA9000. Instructions are available in the 
SPA9000 Voice System Administration Guide. 

• Configuring NAT Mapping with Simple Traversal of UDP through NAT (STUN): 
Configuring NAT mapping in the SPA9000 is recommended only if the ITSP 
network does not provide a Session Border Controller functionality. If this is the 
case, and if the external (Public) IP address is assigned dynamically by the 
network (and the router uses asymmetric NAT mechanism), it is possible to use 
STUN as a mechanism to discover the NAT mapping in SPA9000. This method 
is considered a practice of last resort and should be used only if the other 
methods are unavailable. For more information, see the SPA9000 Voice System 
Administration Guide.
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Quality of Service

Cisco recommends using the SPA9000 Voice System with QoS-capable 
networking equipment that can prioritize the VoIP application traffic. QoS features 
are available on many Cisco data networking switches (such as the SLM224P) and 
routers (such as WRV200). A QoS-enabled router prioritizes the packets going 
upstream to the Internet Service Provider. QoS can be enforced using either DSCP 
(Diffserv Codepoint) ToS (Type of Service) or 802.1 Q/p VLAN ID and priority 
setting. DSCP ToS is recommended for its simplified setup.

Instructions for the SLM224P are provided in this guide. 

Local Area Network Design

Use the following guidelines to manage the LAN setup for the SPA9000 Voice 
System.

• Ensure that all Cisco SPA devices are located in the same local area network 
subnet.

• Although all Cisco SPA devices support static IP addressing, we recommend 
using a DHCP server to add IP telephones to the system. Ensure that the DHCP 
server can assign enough IP addresses to serve the Cisco IP phones and the 
existing networked components such as PCs, servers, and so on.

• If you are using DHCP, use a long lease time. Cisco IP phones may reboot on the 
event of an IP address change because of lease time expiration.

• Use stable DNS server addresses for URL name resolution. Your Internet 
Service Provider can provide the primary and secondary DNS server IP 
addresses.
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Services and Equipment

To install and configure SPA9000 Voice System, you need the following services 
and equipment.

Basic Services and Equipment

The following basic services and equipment are required:

• An Integrated access device or modem for broadband access to the Internet; 
business grade account recommended

• Internet Telephony Service Provider (ITSP) for Voice Over IP telephone service, 
supporting a “bring your own device” model

You must have at least the following information about your account: 

• SIP Proxy (IP address or name)

• Account Information and Password

• Computer with Microsoft Windows XP or Windows Vista (for system 
configuration)

• Analog phone for administrative use with the SPA9000 Interactive Voice 
Response (IVR) system

• Uninterruptible Power Source (UPS), recommended for devices such as the 
Integrated Access Device, network switch, router, and PoE switch to ensure 
continuous operation during a power failure

Cisco Equipment and Services

The following Cisco equipment is recommended:

• SPA9000 IP PBX

One SPA9000 unit is required for IP PBX features. Only one SPA9000 is 
supported.

• SPA400 PSTN Gateway and Voice Mail Server

It is recommended that you install one SPA400 unit exclusively for voice mail 
service and one or more additional SPA400 units for PSTN access. Each unit 
has four FXO ports and occupies one line interface on the SPA9000. With ITSP 
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service taking one line interface on the SPA9000, up to three SPA400 units can 
be installed. With no ITSP service, up to four SPA400 units can be installed.

• SPA9xx series IP phones

The SPA9x1 series phones require access to power outlets. The SPA9x2 
series phones can receive power from a Power over Ethernet (PoE) switch and 
are not supplied with power supplies. If you are not using the recommended 
PoE switch, you need to purchase a suitable power supply or power injector 
for the SPA9x2 phones.

• Switch (example: SLM224P) 

• Router (example: WRV200)

• Optional POES5 Power over Ethernet adapters, for providing POE-derived 
power to non-POE devices such as SPA9000, SPA400 and SPA9x1, in case 
UPS is available.

• Optional WBP54G Wireless-G adapter, for providing Wireless client 
functionality to IP Phones, if required to connect a phone to the LAN using 
Wireless technology.

Downloading Firmware

Cisco recommends that you check for recent updates before you install your 
equipment. Later instructions in this guide will help you to install the firmware that 
you download in this preparation phase. You can find all available updates at 
www.cisco.com/go/smallbiz. 
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Connecting the Equipment

This chapter explains how to connect your equipment and upgrade the firmware. 
At the end of each section, you verify that the installation is progressing correctly.

• “Connecting and Configuring the Switch,” on page 41

• “Installing the SPA9000,” on page 46

• “Installing the IP Phones,” on page 53

• “Installing the SPA400,” on page 58

Connecting and Configuring the Switch

Before installing any equipment, you need to connect the SLM224P Ethernet 
switch to a network broadband router or Integrated Access Device (IAD). If the site 
is not already equipped with another broadband router/IAD, Cisco recommends 
the use of the WRV200 broadband router to connect to the access device.

• “Connecting the Switch to the Router,” on page 42

• “Configuring the Switch,” on page 43

NOTE In this guide, the SLM224P switch is used in all examples. However, various Cisco 
switches can be used with SPA9000 Voice System. Cisco recommends use of the 
SLMxxxP, SRWxxxP and SRWxxxMP switch product families with SPA9000 Voice 
System. For more information, visit www.cisco.com/go/smallbiz.
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Connecting the Switch to the Router

In this procedure, you connect the switch to the router and a power source.   

STEP 1 Connect an Ethernet network cable to one of the Ethernet ports on your router. 
Then connect the other end of the cable to an Ethernet port on the switch.

STEP 2 Connect an administrative computer to an Ethernet port on the switch. The PC 
needs to have an IP address on the same network as the switch, which has a 
default IP address of 192.168.1.254.

STEP 3 Connect the power cord to the back of the switch, and then connect the power 
adapter to an electrical outlet.

The Power LED is solid amber during the Power-On Self Test (POST). Then the 
LED is solid green. You are ready to configure the switch.

SLM224P Ethernet Switch

Internet Integrated 
Access Device

Router

Administration
Computer
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Configuring the Switch

You need to enable port fast to facilitate the broadcast communications between 
the SPA9000 and the phones. You also need to configure the Quality of Service 
settings to help to prevent network delays affecting voice communications. 

• Enable spanning tree and port fast. 

NOTE If the switch does not provide a way to enable port fast, then you must 
disable spanning tree. The preferred method is to enable spanning 
tree and port fast. 

• Enable QoS with DSCP.

Enabling Spanning Tree and Port Fast on the SLM224P Switch

To avoid timing issues related to Spanning Tree Protocol (STP) and to allow 
multicasting to work correctly for SPA9000 Voice System, enable port fast on the 
switch ports that will be connected to the SPA9000 and the SPA9xx IP phones. 

When Port Fast is enabled, Fast Link mode is active. In Fast Link mode, the Port 
State is automatically placed in the forwarding state when the port link is up. Fast 
Link optimizes the STP protocol convergence. STP convergence can take 30-60 
seconds in large networks.

STEP 1 Choose the ports that you will use to connect the SPA9000 and the IP phones. 

STEP 2 Connect the administration computer to the switch.

STEP 3 Start Internet Explorer, and enter the IP address of the switch. The default IP 
address of the switch is 192.168.1.254. The default User ID is admin, with no 
password. After you log on, the Home page appears.

STEP 4 Click Spanning Tree tab > STP Port Settings.

STEP 5 From the Port drop-down list, choose the port number for the SPA9000. 

STEP 6 Make sure that the Enable STP check box is checked, to enable STP on the port.
SPA9000 Voice System Installation and Configuration Guide for Web UI 43



Connecting the Equipment
Connecting and Configuring the Switch 4

 

STEP 7 From the Port Fast drop-down list, choose Enable.

SLM224P Spanning Tree tab > STP Port Settings page

STEP 8 Click Update.

STEP 9 Repeat the previous steps to enable STP and Port Fast on each port where an IP 
phone or a SPA400 will be connected.

STEP 10 Click Save Settings.

Setting QoS on the SLM224P Switch

To avoid possible network related delays, configure QoS on the switch.

STEP 1 Click QoS tab > CoS Settings.

STEP 2 From the QoS Mode list, select Basic.

SLM224P QoS tab > CoS Settings page

STEP 3 Click Save Settings.
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STEP 4 Click QoS tab > Basic Mode.

STEP 5 From the Trust Mode list, select DSCP.

SLM224P QoS tab > Basic Mode page

STEP 6 Click Save Settings.
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Installing the SPA9000

This section explains how to connect the SPA9000 to your switch, to administer it 
with an analog phone and a computer, to upgrade the firmware, and to set up the 
WAN connection.

NOTE This illustration depicts only the devices that are connected at this stage in the 
installation. 

This section includes the following topics:

• “Connecting the SPA9000,” on page 47

• “Upgrading the Firmware for the SPA9000,” on page 48

• “Setting Up the WAN Connection for the SPA9000,” on page 51

SLM224P Ethernet Switch

Internet Integrated 
Access Device

Router

Administration
Computer

Power

SPA9000
IP PBX

Analog 
Phone  for IVR
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Connecting the SPA9000

Follow this procedure to connect your SPA9000 to your switch.

STEP 1 Connect an analog phone to the Phone 1 port of the SPA9000. 

NOTE An analog phone is required for use with administrative Interactive Voice 
Response module. It also can be used as an extension number. 

STEP 2 Optionally, connect a second analog telephone or fax machine directly to the 
Phone 2 port or run cable from Port 2 to a phone that is located elsewhere in the 
office.

STEP 3 Connect an Ethernet network cable to the Ethernet port (yellow) of the SPA9000. 
Then connect the other end of the cable to the Ethernet switch.

STEP 4 Connect an Ethernet network cable to the Internet port (blue) of the SPA9000. 
Connect the other end of the cable to one of the ports on your switch.

STEP 5 Connect the included power cord to the Power port of the System, and then 
connect the power adapter to an electrical outlet.

The Power LED turns red and then green, and then the SPA9000 begins the boot 
process.

• If you would like to provide SPA9000 with Power over Ethernet support, you 
can connect/use POES5 Power over Ethernet adapter.

• If the SPA9000 has been used previously, reset it to the factory defaults before 
you proceed to the other steps in the configuration process. See “To factory 
reset the SPA9000 (if needed),” on page 48.

STEP 6 After the reboot process is completed, start Internet Explorer, and enter the default 
IP address of the SPA9000: 192.168.0.109 

If the system is properly installed, the Info page appears. Your SPA9000 is 
properly powered and has successfully initialized.
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To factory reset the SPA9000 (if needed)

NOTE If your SPA9000 has been used before, we recommend performing a factory reset. 
Otherwise, proceed with enabling WAN Access.

a. Lift the receiver on the analog phone that is connected to the Phone 1 port. 

NOTE There is no dial tone from the IVR.

b. Press the star key (*) four times: ****

c. When the IVR responds, press the code for factory reset: 73738#

d. When prompted, press the code to confirm: 1#

e. Wait about 30 seconds while the system reboots. 

Upgrading the Firmware for the SPA9000

In this procedure, you install any firmware updates that you downloaded from 
www.cisco.com/go/smallbiz in the Preparation phase.

STEP 1 Use the IVR to check the IP address of the SPA9000: 

a. Pick up the receiver of the analog phone that you connected to the SPA9000. 

b. Press **** and then press 110#. 

c. Make a note of the IP address that is announced. 

STEP 2 Use the administration computer to install the latest firmware:

a. Extract the Zip file, and then run the executable file to upgrade the firmware. 

b. When the Firmware Upgrade Warning window appears, click Continue. 
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c. In the next window that appears, enter the IP address of the SPA9000, and then 
click OK. 

d. In the Confirm Upgrade window, verify that the correct device information and 
product number appear. Then click Upgrade. 
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A progress message appears while the upgrade is in progress. The success 
window appears when the upgrade is completed. The device reboots.

STEP 3 Click OK to close the confirmation message. 

STEP 4 To verify the upgrade, start Internet Explorer, and enter the IP address of the 
SPA9000. Check the Router >S tatus page. The Software Version field should 
show the firmware version that you installed.

SPA9000 Router tab > Status page
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NOTE You may need to refresh your browser to display the updated page 
reflecting the new version number.

Setting Up the WAN Connection for the SPA9000

The SPA9000 becomes a DHCP client of any server on the network. The 
recommended setting is to use a static IP address. This configuration provides 
ease of installation and prevents connectivity issues that would occur if the IP 
address of the SPA9000 changed. 

STEP 1 Start Internet Explorer, and enter the IP address of the SPA9000. The Router > 
Status page appears. By default, the page is in Basic User mode. 

STEP 2 Log on to the administrator view by clicking Admin Login, near the top right corner 
of the page. Then click Advanced.

NOTE By default, no password is required. You can assign an administrative 
password later, but it is convenient not to use a password during the initial 
configuration. 

STEP 3 Click Router tab > Wan Setup.

STEP 4 From the Connection Type drop-down list, choose Static IP. 

STEP 5 In the Static IP Settings area, enter the Static IP of the SPA9000, as well as the 
NetMask and Gateway for your network. 

SPA9000 Router tab > Wan Setup page: Static IP Settings section
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STEP 6 In the Optional Settings area, enter the Primary DNS for your network. 

SPA9000 Router tab > Wan Setup page: Optional Settings section

NOTE It is recommended to set an IP address that is outside the address range 
assigned by the DHCP server. For example, if the DHCP server assigns IP 
addresses in the range from 192.168.1.50 to 192.168.1.254, you should select 
a static IP address between 192.168.1.2 and 192.168.1.49.

STEP 7 Click Submit All Changes. The SPA9000 reboots.

STEP 8 To verify your progress, click Router tab > Status. In the System Status section, 
confirm the WAN Connection Type, Current IP, Current Netmask, Current Gateway, 
and Primary DNS.

SPA9000 Router tab > Status page: System Status section
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Installing the IP Phones

Now you can connect the IP phones to the switch.

NOTE The illustration depicts only the devices that are connected at this stage in the 
installation. 

This section includes the following topics:

• “Connecting an IP Phone to the Switch,” on page 54

• “Performing a Factory Reset,” on page 55

• “Connecting Optional Devices,” on page 55

• “Upgrading the Firmware for the IP Phones,” on page 56

IP Phones

Analog Phone Power

SLM224P Ethernet Switch

SPA9000

InternetIntegrated 
Access Device

Router
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Connecting an IP Phone to the Switch

Follow this procedure to connect an IP phone to the switch.

STEP 1 Assemble the IP phone. For more information, refer to the phone user guide.

NOTE If you are connecting the SPA9x1 series phone that requires its own power, 
connect the phone’s power cord to the power port, and then connect the 
power adapter to an electrical outlet. 

STEP 2 Connect the provided Ethernet network cable to the phone, and then connect the 
other end of the cable to a Ethernet port on the multi-port switch. 

After being connected to the switch, the IP phone reboots two to three times. Each 
reboot may take up to one minute. The system automatically assigns an extension 
number to the phone. When the IP phone displays the extension number, it is ready 
to be used for internal (station-to-station) calls. 

NOTE Depending on the installation site requirements, you may need an additional 
accessory to achieve network connectivity. See “Connecting Optional 
Devices,” on page 55 for additional information.

STEP 3 Repeat this procedure for each additional IP phone.

STEP 4 To verify your progress, perform the following tasks:

• Confirm that each phone is displaying an extension number and is registered. 
To check the registration, press the Setup button on the phone keypad. Press 1 
- Status. Scroll down to Ext1, and then press the select soft key. Verify that the 
status is Registered and that the Proxy is the IP address of the SPA9000. 

• Confirm that you can place an internal call from an IP phone by dialing a phone 
extension. 

NOTE You will learn how to configure your system for external calling later in this 
guide.
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Performing a Factory Reset

If an IP phone has been used before, it may not register to the SPA9000 because it 
has the IP address and registration information from a previous SPA9000. To allow 
the auto-provisioning feature of the SPA9000 to configure your phone for you, 
reset it to the factory default settings, as described below. 

STEP 1 Press the Setup button on the phone keypad. 

STEP 2 Press 14 - Factory Reset. 

STEP 3 Press the select soft key to confirm. 

STEP 4 After the phone reboots, the system automatically assigns an extension number to 
the phone.

Connecting Optional Devices

Depending on the site requirements, you may need the following additional 
devices:

• POES5 Power Adapter: The POES5 provides an 802.3af PoE port for 
connection back to a PoE switch. If you have a SPA9x1 series phone and a PoE 
switch, you can connect the POES5 to the phone to allow it to receive PoE.

• MB100 Wall-Mount Kit: The MB100 wall-mount bracket increases the versatility 
of the SPA9000 Voice System by allowing phones to be mounted on walls in 
hallways, sales floors, kitchens, and other locations where desktop placement 
is not practical.

• WBP54G: The Wireless-G Bridge for Phone Adapters allows you to connect an 
IP phone to your wireless network so that you can install the phone in any 
location within range of your wireless router. The IP phone must be connected 
to a power adapter since it is not cabled to the switch. The bridge shares 
electrical power with the IP phone. 
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Upgrading the Firmware for the IP Phones

In this procedure, you install the most recent firmware files for the phones.

NOTE You need to repeat this procedure to upgrade each phone individually.

STEP 1 To find the IP address of the phone, complete the following tasks:

a. Press the Setup button on the phone keypad. 

b. Scroll down to 9 - Network, and then press the Select soft key.

c. Make a note of the Current IP address that is displayed on the phone.

STEP 2 Use the administration computer to install the latest firmware for this model of IP 
phone:

a. Extract the Zip file, and then run the executable file to upgrade the firmware. 

b. When the Firmware Upgrade Warning window appears, click Continue. 

c. In the next window that appears, enter the IP address of the phone, and then 
click OK. 
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d. When the Confirm Upgrade window appears, verify that the correct device 
information and product number appear. Then click Upgrade. 

A progress message appears while the upgrade is in progress. The success 
window appears when the upgrade is completed. The device reboots.
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STEP 3 Click OK to close the confirmation message.

STEP 4 To verify the upgrade, complete the following tasks:

a. Press the Setup button on the phone keypad. 

b. Scroll down to 10 - Product Info, and then press the Select soft key. 

c. Scroll down to 3 - Software Version. 

d. Verify that the new firmware version number appears.

Installing the SPA400

The SPA400 is an integrated part of the SPA9000 Voice System. The SPA400 
provides connectivity to the PSTN network and has an integrated voice mail 
application available on the same platform. Depending on your voice service 
configuration (i.e. combination of VoIP, PSTN and ISDN line/services), you can 
connect up to four SPA400 devices to your SPA9000 Voice System.

This section includes the following topics:

• “Connecting the SPA400 to the Switch,” on page 59

• “Configuring the SPA400 Network Connection,” on page 61

• “Upgrading the Firmware for the SPA400,” on page 63
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Connecting the SPA400 to the Switch

You can connect up to four SPA400 devices to the system.

NOTE

• This illustration depicts only the devices that are connected at this stage in the 
installation. 

• If you install multiple SPA400 units, keep track of the MAC addresses to ensure 
that you know which device you are configuring. In the administration web 
server, you can see the MAC address by clicking the Status tab.

IP Phones

Analog Phone Power Power

Analog Phone Lines

SLM224P Ethernet Switch

SPA9000 SPA400

InternetIntegrated 
Access Device

Router
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STEP 1 Connect the provided Ethernet network cable to the Ethernet port on the SPA400, 
and then connect the other end of the cable to an Ethernet port on the SLM224P 
switch.

STEP 2 If you are using the SPA400 for PSTN access, connect an RJ11 telephone cable to 
one of the line ports on the SPA400, and then connect the other end of the cable to 
the RJ11 wall outlet for the telephone service.

STEP 3 If you are using the SPA400 as a voice mail server, insert the provided USB 1.1 
voice mail module into the USB port.

NOTE IMPORTANT: For optimum voice mail performance, a SPA400 should be 
dedicated to the voice mail application when either of the following 
conditions is met:
1. More than 2 FXO connections are required

OR
2. More than 2 users commonly access voice mail at the same time.

STEP 4 Connect the provided power adapter to the power port on the SPA400, and then 
connect it to an electrical outlet.

NOTE If you would like to provide SPA400 with Power over Ethernet support, 
connect a POES5 Power over Ethernet adapter.

STEP 5 To verify your progress, confirm that the Power LED on the SPA400 flashes and 
then shines steady green. The Status LED remains flashing until the SPA400 is 
registered to the SPA9000. 

NOTE You will learn how to configure the SPA400 in Chapter 5, “Configuring Phone 
Service and Voice Mail.”
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Configuring the SPA400 Network Connection

You need to configure a fixed IP address for your SPA400.

STEP 1 Start Internet Explorer, and enter the IP address of the SPA400.

• By default, the SPA400 is configured to obtain an IP Address via DHCP. You can 
check the obtained IP address on the router DHCP server’s client list. 

• If your SPA400 has been used before or it is not reachable, factory reset the 
unit by pressing the Reset button for 10 seconds.

STEP 2 When the password prompt appears, enter the default user name, Admin, with no 
password. Then click OK.

NOTE The user name must be entered exactly as shown: Admin. For information 
about managing system access, refer to the Cisco SPA9000 Voice System 
Administration Guide. 

STEP 3 Click Setup tab > Basic Setup.
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STEP 4 Enter the following settings:

Network Setup section:

• Fixed IP address: Click the radio button, and then enter a valid IP address. 

NOTE To avoid addressing conflicts, enter an IP address that is outside the 
range of addresses that are automatically assigned by your DHCP 
server.

• IP Subnet Mask: Enter the subnet mask for the subnetwork that the SPA400 is 
on.

• Gateway IP Address: Enter the IP address of the router for this subnetwork. 

Domain Name Server (DNS) Address section:

• Primary DNS: Enter the IP address of the primary DNS server.

• Secondary DNS: Enter the IP address of the secondary DNS server.

NTP section:

• NTP: Enter a fully qualified name of a Network Time Protocol server, such as 
time.nist.gov.

• Time Zone: Select the time zone for your region.

STEP 5 Click Save Settings. The SPA400 will reboot. To reconnect to the web 
administration server, enter the new IP address for the SPA400 in the browser 
Address bar.
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Upgrading the Firmware for the SPA400

In this procedure, you install any firmware updates that you downloaded from 
www.cisco.com/go/smallbiz in the Preparation phase.

NOTE You need to repeat this procedure to upgrade each SPA400 individually.

STEP 1 Start Internet Explorer, and enter the IP address of the SPA400.

NOTE By default, the SPA400 is configured to obtain an IP Address via DHCP. You 
can check the obtained IP address on the router DHCP server’s client list. 

STEP 2 When the password prompt appears, enter the default user name, Admin, with no 
password. Then click OK.

NOTE The user name must be entered exactly as shown: Admin. For information 
about managing system access, refer to the Cisco SPA9000 Voice System 
Administration Guide. 

STEP 3 Click Administration tab > Firmware Upgrade.

STEP 4 Click Browse.

SPA400 Administration tab > Firmware Upgrade page

STEP 5 Find the binary (.bin file) that you extracted to your Desktop, and click Open.
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STEP 6 Click Upgrade.

STEP 7 When the confirmation message appears, click OK.

STEP 8 When the Setup page reappears, verify that the Firmware Version number 
matches the version that you installed. You have successfully upgraded the 
firmware. 

NOTE You may need to refresh your browser to display the updated banner 
reflecting the new version number.

Congratulations, your SPA9000 Voice System is installed and ready for 
configuration. Proceed to Chapter 5, “Configuring Phone Service and Voice Mail.” 
to start the configuration of the SPA9000 Voice System services.
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Configuring Phone Service and Voice Mail

This chapter guides you through the basic tasks that are required to get your voice 
system running. After you complete these procedures, users will be able to place 
and receive calls from the ITSP and from the PSTN. Callers will be able to leave 
voice mail, and users will be able to retrieve it.

NOTE You have several options in setting up your system. For example, you may have 
Internet phone service, analog telephone service, or both. You may have local voice 
mail that is integrated into the SPA9000 Voice System, you may have external voice 
mail, or you may have none. The procedures indicate which steps can be skipped 
for various scenarios. 

It is recommended that you complete the procedures in the order in which they 
are presented. Refer to the following topics:

• “Configuring the SPA9000,” on page 66

• “Configuring the SPA400,” on page 76

• “Setting Up Each Station,” on page 84

• “Enabling Remote Voice Mail Access (Optional),” on page 88

• “Configuring Third-Party ISDN Gateways (Optional),” on page 89

• “Outbound Call Routing,” on page 90

• “Configuring Inbound Call Routing,” on page 94
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Configuring the SPA9000

On the SPA9000, you configure a “line” for ITSP phone service and another “line” 
for SPA400 services such as PSTN access and voice mail. 

• “Configuring General Settings for SPA9000,” on page 66

• “Configuring Internet Phone Service (ITSP) on the SPA9000,” on page 68

• “Configuring SPA9000 Connectivity with the SPA400 for PSTN and Voice Mail 
Service,” on page 70

• “Configuring SPA9000 Connectivity for PSTN Access Only,” on page 74

Configuring General Settings for SPA9000

There are several settings that are recommended to ensure good performance on 
your voice network. Complete this procedure before performing any other 
configuration tasks.

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click Voice tab > SIP.

STEP 3 Enter the following settings:

• Under PBX Parameters, set Force Media Proxy to Yes. This setting ensures that 
the voice path goes through the SPA9000, which acts as a media relay.

SPA9000 Voice tab> SIP page: PBX Parameters section
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• In the PBX Phone Parameters section, set CTI Enable to Yes. This setting 
supports special features such as Busy Lamp Field. 

SPA9000 Voice tab > SIP page: PBX Phone Parameters section

• In the Auto Attendant Parameters section, set AA Decode Inband DTMF to Yes. 
This setting is required only if the ITSP uses inband signalling. This setting 
allows the AA to decode the inband signalling and to recognize the caller’s key 
presses. 

SPA9000 Voice tab > SIP page: Auto Attendant Parameters section

STEP 4 Click the Submit All Changes button. The SPA9000 device reboots.
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Configuring Internet Phone Service (ITSP) on the SPA9000

If you are using Internet phone service, you need to configure the SPA9000 with 
the account information. In this procedure, you use the SPA9000 web 
configuration utility to enter the logon information and the address of the proxy 
server. After you complete these steps, you will verify that the phone service is 
registered and that you can place and receive calls.

NOTE This procedure is required if you are using Internet phone service. If you are using 
PSTN access only (via the SPA400), go to the next procedure, ““Configuring 
SPA9000 Connectivity with the SPA400 for PSTN and Voice Mail Service,” on 
page 70.

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click Voice tab > Line 1.

NOTE Any line can be used for ITSP service. However, for simplicity and 
consistency throughout this Install Guide, Line 1 is used for this purpose.

STEP 3 Enter the account information for your ITSP account:

• User ID: The account number or logon name for your ITSP account (often the 
same as the phone number)

• Password: The password for your ITSP account

• Proxy: The proxy server for your ITSP account
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Use the following illustration as a guide.

SPA9000 Voice tab > Line 1 page

• SIP Port: You can keep the default value of 5060 for Line 1. Each line must have 
a unique SIP port.

• Contact List: Leave the default value, aa, for the Auto Attendant. Later, you can 
make changes. Using this basic setting at this point simplifies your testing and 
verification of the configuration. 

STEP 4 Click Submit All Changes. The SPA9000 reboots.

STEP 5 To verify your progress, perform the following tasks:

• After the devices reboot, click Voice tab > Info. Scroll down to the Line 1 Status 
section. Verify that the line is registered. You may need to refresh the browser 
screen to see the new status. 

SPA9000 Voice tab > Info page: Line 1 Status section

• Use an external phone, such as a cell phone, to place an inbound call to the 
telephone number that was assigned by your ITSP. Assuming that you have left 
the default settings in place, the Auto Attendant answers the call. You can then 
dial an extension number to verify that the call rings to the station.
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NOTE If the line is not registered, you may need to refresh the browser several 
times because it can take a few seconds for the registration to succeed. If 
your test call does not go through to the Auto Attendant, you should review 
the procedure to verify that you entered the correct information. Also verify 
that your DNS is configured properly.

Configuring SPA9000 Connectivity with the SPA400 for 
PSTN and Voice Mail Service

The SPA400 acts as a gateway to the PSTN and provides an integrated voice mail 
application. You can set up your SPA9000 Voice System network to use either or 
both of these services:

• PSTN Access (optional if you have internet telephone service): Each SPA400 
can connect up to four standard analog telephones lines to a SPA9000 Voice 
System VoIP network to provide access to the Public Switched Telephone 
Network (PSTN). The SPA400 sets up and tears down calls between the PSTN 
and IP Phones offering seamless telephone service with Cisco VoIP 
equipment. To enable this service, you assign a User ID and port on the 
SPA400, and you configure the corresponding “Line” settings on the SPA9000. 
The SPA9000 Voice System network then recognizes the SPA400 as a service 
that allows calls to be routed to and from the PSTN. 

• Voice Mail Service (optional if you have other voice mail service): The SPA400 
includes a USB adapter with an integrated voice mail application for users and 
extensions that are configured on the SPA9000. The integrated voice mail 
application server supports 32 configurable voice mail accounts. Although a 
SPA9000 can be configured with up to four SPA400 devices, only one SPA400 
can be configured with the voice mail server. 

IMPORTANT: For optimal voice mail performance, a SPA400 should be 
dedicated to the voice mail application when either of the following conditions 
is met:

1. More than 2 FXO connections are required

OR

2. More than 2 users commonly access voice mail at the same time.
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In the following procedure, you configure the SPA9000 to register to the SPA400. If 
you are using the SPA400 as a voice mail server, you also enter the settings to 
subscribe to that service.

NOTE The first part of this procedure is required whether you are using the SPA400 for 
either PSTN access or voice mail. The second part of the procedure is required 
only if you are using the SPA400 as a voice mail server.

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click Voice tab > Line 2.

NOTE Any line can be used; however, for consistency throughout this Install Guide, 
Line 1 is used for ITSP service and Line 2 is used for the SPA400 interface.

STEP 3 Enter the following information about the SPA400:

• User ID: 9000
This ID corresponds to the User ID that you will enter on the SPA400 
configuration page. The entries must match exactly.

• Proxy: Enter the IP address of the SPA400.

• Registration Expires: 60
This setting ensures that the SPA9000 and SPA400 are resynchronized every 
60 seconds. This setting ensures that any changes in settings are synchronized 
on both devices. 
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SPA9000 Voice tab > Line 2 page

STEP 4 Also in the Proxy and Registration section, enter the following settings to ensure 
that calls can be transferred and forwarded to the voice mail server:

• Set VMSP Bridge to all (required if this line is being used for SPA400 voice mail 
service).

• Set XFER Bridge Mode to all.

• Set CFWD Bridge Mode to all.

SPA9000 Voice tab > SIP page: Proxy and Registration section

• SIP Port: You can keep the default value of 5061 for Line 2. Each line must have 
a unique SIP port.

• Contact List: Leave the default value, aa, for the Auto Attendant. Later, you can 
make changes. Using this basic setting at this point simplifies your testing and 
verification of the configuration. 
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STEP 5 If you are not configuring SPA400 voice mail, go to Step 6. To set up SPA400 voice 
mail service, enter the following settings:

• Mailbox Deposit URL: 900@<IP address of SPA400>:5090
The SPA9000 uses this address to deposit voice mail on the voice mail server.

• Mailbox Manage URL: 800@<IP address of SPA400>:5090
The SPA9000 uses this address to access voice mail on the voice mail server.

• Mailbox Subscribe URL: 8888@<IP address of SPA400>:5090
The SPA9000 uses this address to subscribe to voice mail service on the voice 
mail server.

• Mailbox Subscribe Expires: 30
This setting ensures that the SPA9000 and the SPA400 voice mail server are 
resynchronized every 30 seconds, and prevents problems when you make 
changes in the settings. 

Use the following illustration as a guide.

SPA9000 Voice tab > SIP page: Proxy and Registration section

STEP 6 ****Click Submit All Changes. The SPA9000 device reboots. The SPA9000 is now 
configured to register the SPA400. 

NOTE You will perform the verification steps after you configure the SPA400.
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Configuring SPA9000 Connectivity for PSTN Access Only

You can configure the SPA9000 so that the users can place and receive calls 
through PSTN lines that are connected to a SPA400, or to multiple SPA400 
devices. Set up a line interface for each SPA400 that you connect.

NOTE This step is required if you want to configure another SPA400 for PSTN access only.

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click Voice tab > Line 3.

NOTE Any line can be used; however, for consistency throughout this Install Guide, 
Line 1 is used for ITSP service, Line 2 is used for the SPA400 that has voice 
mail service, and Line 3 is used for a second SPA400 that has PSTN access.

STEP 3 Enter the following information about the SPA400:

• User ID: 9000
This ID corresponds to the User ID that you entered on the SPA400 
configuration page. They must match exactly.

• Proxy: Enter the IP address of the SPA400.
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• Register Expires: 60
This setting ensures that the SPA9000 and SPA400 are resynchronized every 
60 seconds. This setting ensures that any future changes in settings are 
synchronized on both devices. 

Use the following illustration as a guide.

SPA9000 Voice tab > SIP page

STEP 4 Click Submit All Changes.
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Configuring the SPA400

If you have a SPA400 in your network, you need to configure the SPA400 to 
communicate with the SPA9000. In addition, if you are using the SPA400 as a voice 
mail server, you need to configure the voice mail settings.

• “Configuring the SPA400 Network Connection,” on page 76

• “Configuring the SPA400 to Communicate with the SPA9000,” on page 78

• “Configuring the Voice Mail Server and Voice Mail Users,” on page 82

Configuring the SPA400 Network Connection

The SPA400 becomes a DHCP client of any server on the network. The 
recommended setting is to use a static IP address. This configuration provides 
ease of installation and prevents connectivity issues that would occur if the IP 
address of the SPA400 changed. 

STEP 1 Start Internet Explorer, and enter the IP address of the SPA400.

NOTE By default, the SPA400 is configured to obtain an IP Address via DHCP. You 
can check the obtained IP address on the router DHCP server’s client list. 

STEP 2 When the password prompt appears, enter the default user name, Admin, with no 
password. Then click OK.
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NOTE The user name must be entered exactly as shown: Admin. For information 
about managing system access, refer to the Cisco SPA9000 Voice System 
Administration Guide. 

STEP 3 Click Setup tab > Basic Setup.

STEP 4 Enter the following settings:

Network Setup section:

• Fixed IP address: Click the radio button, and then enter a valid IP address. 

NOTE To avoid addressing conflicts, enter an IP address that is outside the 
range of addresses that are automatically assigned by your DHCP 
server.

• IP Subnet Mask: Enter the subnet mask for the subnetwork that the SPA400 is 
on.

• Gateway IP Address: Enter the IP address of the router for this subnetwork. 

Domain Name Server (DNS) Address section:

• Primary DNS: Enter the IP address of the primary DNS server.

• Secondary DNS: Enter the IP address of the secondary DNS server.

NTP section:

• NTP: Enter a fully qualified name of a Network Time Protocol server, such as 
time.nist.gov.

• Time Zone: Select the time zone for your region.
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SPA400 Setup tab > Basic Setup page

STEP 5 Click Save Settings. The SPA400 will reboot. To reconnect to the web 
administration server, enter the new IP address for the SPA400 in the browser 
Address bar.

Configuring the SPA400 to Communicate with the SPA9000

In the following procedure, you use the SPA400 web configuration utility to enter 
the information that enables the SPA400 to communicate with the SPA9000. You 
also enter QoS settings to ensure good voice quality on your system. In addition, 
you enter the codec settings.

NOTE This procedure is required whether you are using the SPA400 for PSTN access, for 
voice mail service, or both.
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STEP 1 Click Setup tab > SPA9000 Interface.

STEP 2 Enter the following settings:

• User ID: 9000
This is the user ID that the SPA9000 will use to register with the SPA400. Any ID 
can be used, but must match exactly the User ID that you entered on the 
corresponding SPA9000 Voice > Line page. 

• SPA9000 Address: Select the Discover Automatically radio button (required for 
SPA9000 operation). This setting enables the SPA400 to learn the IP address 
and the UDP port of the SPA9000 the from the SIP Registration packets sent by 
SPA9000. 

• Call Signalling Packets: 68

• RTP Packets: b8

• Leave the Signalling Port at the default value of 5060. This port is the source 
port that is used to originate signaling between the SPA400 and the SPA9000. 

• Leave the RTP Port at the default value of 10000. This port is the base UDP 
port for the block of UDP ports that the SPA400 uses to send and receive RTP 
and RTCP packets.

• Leave the Session Timer fields at the default values: Enabled with 0 seconds in 
both Refresh Time fields.

STEP 3 Click Save Settings at the bottom of the page.

STEP 4 Click Setup tab > Voice.

STEP 5 Enter the following settings on the Voice page:

• Preferred Codec: Select G.711u.

• Packetization: Choose 30ms from the Packetization drop-down list for G.711U.

• VAD: Choose OFF from the VAD drop-down list for G.711U.
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Use the following illustration as a guide.

SPA400 Setup tab > Voice page

STEP 6 Click Save Settings at the bottom of the page.

STEP 7 To restart the SPA400, complete the following steps:

a. Click Administration tab > Reboot.

b. Click Restart System. 

c. When the confirmation message appears, click OK. The SPA400 reboots. 

d. When the Reboot OK. Go to Setup Page? message appears, click OK and wait 
for 60 seconds (the time required for the SPA9000 to re-register with SPA400).

STEP 8 To verify your progress, perform the following tasks:

a. Click the Status tab, and confirm that the SIP registration status is Registered. 

SPA400 Status tab
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b. If you connected PSTN lines to the ports on the SPA400, confirm that you can 
place an external call to the phone number that is associated with the PSTN 
line. The Auto Attendant answers the call. You can then dial one of the 
extension numbers to verify that the call rings to the station. Also verify that a 
voltage value appears under Battery Level.

c. Start Internet Explorer, and then enter the IP address of the SPA9000. Log on as 
Admin, and then click Voice> Info. Verify that the Line 2 Status is Registered. 
You may need to refresh the browser screen to see the new status. 

STEP 9 Proceed as needed:

• If you are using the SPA400 for voice mail service, continue to “Configuring the 
Voice Mail Server and Voice Mail Users,” on page 82. 

• If you are not using the SPA400 for voice mail service, you have finished 
configuring your SPA400.
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Configuring the Voice Mail Server and Voice Mail Users

In the following procedure, you enter the settings that allow the SPA400 to act as a 
voice mail server. These settings correspond to those that you entered on the Line 
2 page in the SPA9000 configuration. Later you will enter corresponding settings 
in the phone configuration. 

NOTE This procedure is not required if you are using an external voice mail service.

STEP 1 If your web browser is not already connected to the SPA400 web configuration 
utility, start Internet Explorer, and enter the IP address of the SPA400, and log on.

STEP 2 To configure the voice mail server, complete the following tasks (required): 

a. Click Setup tab > Voice mail Server.

b. Enter the following information:

• Server Port: 5090 
The voice mail server uses this UDP port to listen for signalling between the 
SPA400 and the SPA9000. This port must be different from the port number 
that you entered on the SPA9000 Interface page.

• SPA9000 subscriber ID: 8888 
The SPA9000 uses the subscriber ID to subscribe to the SPA400 Voice mail 
Server for obtaining notification. 

• Mailbox deposit number: 900 
The SPA9000 uses the deposit number to deposit voice mail on the voice 
mail server. 

• Mailbox manage number: 800 
The SPA9000 uses the deposit number to access voice mail on the voice 
mail server. 
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Use the following illustration as a guide.

SPA400 Setup tab > Voicemail Server page

c. Click Save Settings. 

STEP 3 Configure the voice mail users (required):

a. Click Setup > Voicemail Users. 

b. Enable the voice mail accounts and enter the user’s extensions and passwords:

• Enable: Check the check box to enable the voice mail account.

• User ID: Enter the user’s extension number.

• Password: Enter a password for this user. Users can change their own 
passwords after logging on with the assigned password.

SPA400 Setup tab > Voicemail Users page

NOTE Later you will set up the voice mail for each station.

STEP 4 Click Save Settings at the bottom of the page.
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STEP 5 Restart the SPA400 by completing the following steps:  

a. Click Administration  tab > Reboot.

b. Click Restart System. 

c. When the confirmation message appears, click OK. The SPA400 reboots. 

d. When the Reboot OK. Go to Setup Page? message appears, click OK.

STEP 6 To verify your progress, click the Status tab, and verify the following settings:

a. USB status: Mount

b. Voice mail status: OK

c. SPA9000 Registration status: Registered 

NOTE If the SPA registration status is not Registered, trying powering off the 
SPA9000 and powering it on again. 

STEP 7 Continue to the next procedure, “Setting Up Each Station,” on page 84.

Setting Up Each Station

To set up each station, you need to assign a name, configure general settings, and 
enable voice mail access (if applicable). 

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click PBX Status, near the top right corner of the page.
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The screen lists each phone by Station Name and Extension number. 

SPA9000 PBX Status page

STEP 3 Find the phone that you want to configure, and then click the hyperlink in the IP 
Address column. 

The Telephone Configuration page appears in a separate browser window. 

STEP 4 To enter a station name for the phone (recommended), complete the following 
tasks:

a. Click the Phone tab.

b. Under General, enter a Station Name. 

Telephone Configuration > Phone page: General section

NOTE This setting assists you in managing the phones.
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STEP 5 To configure voice mail service with the SPA400 voice mail server, complete the 
following tasks: 

a. Click the Ext 1 tab.

b. Under Call Feature Settings, enter the Mailbox ID in the following format:
<lineN><mailbox>
Example: 2105

• lineN: The SPA9000 line (1, 2, 3, or 4) that is configured with the voice mail 
settings
In the example, 2 is the first digit in the Mailbox ID because you previously 
configured Line_2 with the settings for the SPA400 voice mail server. By 
comparison, if you had configured Line 3 for the SPA400 voice mail server, 
you would enter_3 as the first number in the Mailbox ID. 

• mailbox: The voice mailbox number for this station, as configured on the 
SPA400 Voice Mail Users page (see “Configuring the Voice Mail Server and 
Voice Mail Users,” on page 82.) In the example, 105 is the final set of digits 
in the Mailbox ID because this station retrieves voice mail from mailbox 105. 
Enter the appropriate mailbox number for the station that you are 
configuring. 

Telephone Configuration > Ext 1 page: Call Feature Settings section

c. Verify that the Voice Mail Server field displays the SPA400_IPaddress:6060., 
such as 192.168.40.109:6060.

d. Click Submit All Changes. The phone reboots.

STEP 6 Close the browser window for this station. 

STEP 7 Return to the browser window that shows the list of stations, and then repeat this 
procedure for each station.

NOTE When you finish configuring stations, you can click the browser’s Back 
button to return to the main web configuration page, or you can close the 
browser.
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STEP 8 To verify your progress, perform the following tasks: 

• Station Name: Verify that the station name appears on the phone display and in 
the list of stations on the PBX Status page.

• Mailbox Status: Click Voice tab > Line 2. In the Proxy and Registration section, 
check the Mailbox Status field. You should see a listing for each extension that 
you configured with voice mail. 

SPA9000 Voice tab > Line 2 page: Proxy and Registration section

• Voice Mail: Press the Message button. You hear one of the following 
responses:

• “Password” prompt: This prompt indicates that the station is configured 
properly. You can enter the password and manage the mailbox. 

• “Mailbox number” prompt: This prompt indicates that no mailbox is 
assigned to this station. Review the settings on the SPA400 Setup tab > 
Voicemail User page (see “Configuring the Voice Mail Server and Voice 
Mail Users,” on page 82) and the Phone configuration page (see “Setting Up 
Each Station,” on page 84).

• Busy Tone: A busy tone indicates a problem with the configuration. Verify 
that the USB drive is properly inserted into the SPA400. Verify that the 
correct data was entered on the SPA9000 > Line 2 configuration page (see 
“Configuring SPA9000 Connectivity with the SPA400 for PSTN and Voice 
Mail Service,” on page 70). Verify that the mailbox was set up on the 
SPA400 (see “Configuring the Voice Mail Server and Voice Mail Users,” on 
page 82) and that the correct line and mailbox were entered on the Phone 
configuration page (see “Setting Up Each Station,” on page 84).
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Enabling Remote Voice Mail Access (Optional)

Follow this procedure to allow users to access their voice mail remotely.

NOTE If your users will call into your voice mail system through an ITSP line, your ITSP 
must support out-of-band DTMF. 

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click Voice > SIP.

STEP 3 Scroll down to the Auto Attendant Parameters section. 

STEP 4 Edit the AA Dial Plan 1 string to include a code for the voice mail server, as 
described below. 

• SYNTAX: (10x | xxx. | <dialcode:vmmN>)

• EXAMPLE: (10x | xxx. | <8:vmm2>)

• dialcode: The digit that users dial, when prompted by the Auto Attendant, to 
access voice mail remotely. 

NOTE The Contact List for this line must be configured for the Auto Attendant 
to answer.

• MailboxManageNumber: The Mailbox Manage Number that was entered on the 
SPA400 Voice mail Settings page. 

• vmmN: Replace N with the number of the SPA9000 line interface (Line 1 ... Line 
4) that is configured for the SPA400 voice mail server.

SPA9000 Voice tab > SIP page: Auto Attendant Parameters section
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STEP 5 Copy and paste the same string into the AA Dial Plan 2 field, for the purpose of 
allowing remote access of voice mail at all times of day. For more information 
about AA Dial Plans, refer to the SPA9000 Administrator Guide.

STEP 6 Click Submit All Changes. The SPA9000 and the phones reboot.

STEP 7 To verify your progress, perform the following tasks:

a. Dial into the site from an external number. 

b. When the Auto Attendant prompts you for an extension, press 8. 

c. When the Voice Mail Server prompts for a mailbox number, enter the mailbox 
number.

d. When prompted for a password, enter the password. 

Configuring Third-Party ISDN Gateways (Optional)

Optionally, you can connect an ISDN gateway to your SPA9000 Voice System to 
provide access to ISDN phone services, typically via one or multiple Basic Rate 
Interface (BRI) access.

Each ISDN gateway occupies one SIP Line, similar to the SPA400. 

The SPA9000 supports the following third party ISDN gateways:

• Mediatrix® 4401 BRI Digital Gateway – 1 BRI

• Mediatrix® 4402 BRI Digital Gateway – 2 BRI

• Mediatrix® 4404 BRI Digital Gateway – 4 BRI

To configure SPA9000 and Mediatrix® 4400 Series ISDN gateways, download 
and follow the instructions in the SPA9000-Mediatrix® 4400 ISDN Gateways 
Configuration Guide. at www.cisco.com/web/partners/sell/smb/.
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Outbound Call Routing

By default, all external calls are placed by pressing 9. You may want to set up 
different steering digits so that users can choose the line for an outbound call. For 
example, you may want users to press 8 for the ITSP service that is configured on 
Line 1, and to press 9 for the PSTN service that is configured on Line 2.

This section includes procedures and examples.

• “Configuring Steering Digits,” on page 90

• “Typical Outbound Call Routing Examples,” on page 93

• “Routing Calls to the Auto Attendant (Default),” on page 94

• “Routing Calls to a Receptionist, Extension, or Hunt Group,” on page 96

• “Using Direct Inward Dialing to Phone Extensions,” on page 97

Configuring Steering Digits

Follow this procedure to configure the steering digits.

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click Voice tab > SIP.

STEP 3 To configure the call routing rules for outbound calls, complete the following tasks:

a. Scroll down to the PBX Parameters section.

b. Edit the Call Routing Rule to include a code for the voice mail server, as 
described below. 

NOTE The default string is: (<:L1,2,3,4>9xx.)

SYNTAX: (<:L1,backupline>digitsxx. | <:L2> digitsxx. | <:L3> 
digitsxx. | <:L4> digitsxx.)
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• L1, L2, L3, L4: The lines that are configured on the SPA9000 Voice tab > 
Line pages (Line 1 ... Line 4).

• Backupline: The line interface number of the PSTN/ISDN line that is used for 
backup of the ITSP  VoIP Service (i.e. 2, 3, 4). It is assumed and 
recommended that ITSP connection is configured always on Line 1, 
whereas Line 2, Line 3, and Line 4 can be used for connecting to the PSTN 
(via SPA400) or ISDN (via a third party gateway).

• Digits: The steering digits that are used to select the corresponding line; for 
example 9.

EXAMPLE 1: In this example, a user would press 9 for Line 1 and 8 for Line 2:
<:L1>9xx. | <:L2>8xx.)

EXAMPLE 2: In this example, a user would press 9 for Line 1 (ITSP), 8 for Line 2 
(PSTN) and will use Line 2 as backup of Line 1.
(<:L1,2>9xx. | <:L2>8xx.)

c. Under PBX Phone Parameters, enter the appropriate code in the Dial Plan field:

• For United States:
(sdigits,[3469]11S0 | sdigits,<:1408>[2-9]xxxxxx | 
sdigits,<:1>[2-9]xxxxxxxxxS0 | sdigits,1[2-9]xxxxxxxxxS0 
| sdigits,011xx. | sdigits,xx. | [1-8]xx)

• For European countries:
(sdigits,xxS3 | sdigits,xxxS3 | sdigits,[1-9]xxxxxxxxS0 
| sdigits,xx. | [1-8]xx)

• For any other country:
(sdigits,xxxS3 | sdigits,[1-9]xxxxxxxxS0 | sdigits,xx. | 
[1-8]xx)

NOTES:

• sdigits: Steering digits for outbound calling. 

• If there is more than one line connected, then include the steering digits in 
the following format: [sdigit1sdigit2]. For example, if the system is 
connected to an ITSP via Line 1 (with 9 as steering digit) and to the PSTN via 
the SPA400 on Line 2 (with 8 as steering digit), you would enter the 
following dial plan:
([89],[3469]11S0 | [89],<:1408>[2-9]xxxxxx | 
[89],<:1>[2-9]xxxxxxxxxS0 | [89],1[2-9]xxxxxxxxxS0 | 
[89],011xx. | [89],xx. | [1-8]xx)
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• If there is only one line connected, then include a single steering digit. For 
example, if system is connected to an ITSP via Line 1 only and a user needs 
to press 9 to dial out, you would enter the following dial plan:
(9,[3469]11S0 | 9,<:1408>[2-9]xxxxxx | 9,<:1>[2-
9]xxxxxxxxxS0 | 9,1[2-9]xxxxxxxxxS0  | 9,011xx. | 9,xx. 
| [1-8]xx)

STEP 4 Configure the corresponding dial plan rule for each line, as described in the 
following steps:

a. Click Voice tab > Line 1.

b. Scroll down to the Dial Plan section.

c. Change the Dial Plan string, as needed, to include the same steering digit that 
you configured for L1 in the Call Routing Rule. 

NOTE In case you are using a Line (2, 3, 4) for backup of Line 1, you need to 
include in the backup Line dial plan, the entry of the Line 1 dial plan.

SYNTAX: (<digit:>xx.)

EXAMPLE 1: A user presses 9 to access Line 1.
Call Routing Rule: (<:L1>9xx.) 
Line 1 Dial Plan: (<9:>xx.)

EXAMPLE 2: A user presses 9 to access Line 1 and presses 8 to access Line 2.
Call Routing Rule: (<:L1>9xx. | <:L2>8xx.) 
Line 1 Dial Plan: (<9:>xx.) 
Line 2 Dial Plan: (<8:>xx.)

EXAMPLE 3: A user presses 9 to access Line 1 and presses 8 to access Line 2. 
Line 2 is used as backup of Line 1.
Call Routing Rule: (<:L1,2>9xx. | <:L2>8xx.)
Line 1 Dial Plan: (<9:>xx.)
Line 2 Dial Plan: (<8:>xx. | <9:>xx.)

STEP 5 Repeat the previous step to configure each active line.

STEP 6 Click Submit All Changes.

STEP 7 To verify call routing rule, place an outbound call to an external cell phone or other 
phone with caller ID, and confirm that the specified line was used for the call. 
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STEP 8 To verify that a backup line is working, disable the primary line first, and then place 
a call to confirm that the call is transmitted through the backup line.

Typical Outbound Call Routing Examples

The following examples show how you can accomplish various call routing goals 
by editing the call routing rule and the dial plans.

• ITSP Only: Line 1 is configured for ITSP service. The user (in USA) would like to 
press 9 to dial outbound (default configuration).

• Call Routing Rule: (<:L1>9xx.)

• Phone dial plan (US): (9,[3469]11S0 | 9,<:1408>[2-9]xxxxxx | 
9,<:1>[2-9]xxxxxxxxxS0 | 9,1[2-9]xxxxxxxxxS0 | 9,011xx. 
| 9,xx. | [1-8]xx)

• Line 1 Dial plan: (<9:>xx.)

• ITSP and PSTN Service: Line 1 is configured for ITSP service and Line 2 for a 
SPA400 connected to PSTN service. The user (in USA) would like to press 9 for 
Line 1 and to press 8 for Line 2 to make outbound calls.

• Call Routing Rule: (<:L1>9xx. | <:L2>8xx.)

• Phone dial plan (US): ([89],[3469]11S0 | [89],<:1408>[2-
9]xxxxxx | [89],<:1>[2-9]xxxxxxxxxS0 | [89],1[2-
9]xxxxxxxxxS0 | [89],011xx. | [89],xx. | [1-8]xx)

• Line 1 Dial plan: (<9:>xx.)

Line 2 Dial plan: (<8:>xx.)

• ITSP and PSTN with Backup Line: Line 1 is configured for ITSP service and Line 
2 for a SPA400 connected to PSTN service. The user (in USA) would like to 
press 9 for Line 1 and to press 8 for Line 2 to make outbound calls. In addition, 
in case of broadband failure, the user would like to route all calls to the PSTN 
services (Line 2 used also as backup line of Line 1).

• Call Routing Rule: (<:L1,2>9xx. | <:L2>8xx.)

• Phone dial plan (US): (89],[3469]11S0 | [89],<:1408>[2-
9]xxxxxx | [89],<:1>[2-9]xxxxxxxxxS0 | [89],1[2-
9]xxxxxxxxxS0 | [89],011xx. | [89],xx. | [1-8]xx)
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• Line 1 Dial plan: (<9:>xx.)

• Line 2 Dial plan: (<8:>xx. | <9:>xx.)

• ITSP, PSTN, and ISDN, with International Dialing: Line 1 is configured for ITSP 
service, Line 2 for a SPA400 connected to PSTN service, and Line 3 for a third-
party ISDN gateway. The user (in Spain) would like to press 0 for Line 1, which 
is going to be used for international calls, and to press 9 PSTN and ISDN lines, 
which are going to be used for national, local, and mobile calls. Then the user 
would like to route all outbound national and local calls through the ISDN line, 
with exception of mobile numbers (in this example mobile numbers start with 
6). Those calls should be routed to the PSTN line.

• Call Routing Rule: (<:L1>0xx. | <:L2>96xx. | <:L3>9xx.)

• Phone dial plan (Spain): [09],[01][1689][012]S0 | [09],[1-
9]xxxxxxxxS0 | [09],xx. | [1-8]xx)

• Line 1 Dial plan: (<0:>xx.)

• Line 2 Dial plan: (<9:>xx.)

• Line 3 Dial plan: (<9:>xx.)

Configuring Inbound Call Routing

Inbound call routing defines how external incoming calls are handled and routed 
by the SPA9000 Voice System. You can configure the following options to handle 
the incoming calls:

• Step “Routing Calls to the Auto Attendant (Default),” on page 94

• “Routing Calls to a Receptionist, Extension, or Hunt Group,” on page 96

Routing Calls to the Auto Attendant (Default)

By default, all incoming calls are routed to the Auto Attendant, where users are 
prompted to enter the extension number of the destination phone.

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click Voice tab > Line 1.
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STEP 3 In the Contact List field, enter: aa

STEP 4 Repeat steps 3-4 for all active lines.

STEP 5 Adjust the Day Time Answer Delay:

a. Click Voice tab > SIP, and scroll down to the Auto Attendant Parameters 
section.

b. In the Daytime Answer Delay field, enter the number of seconds that the Auto 
Attendant will wait before answering a call. The default value is 12 seconds.

STEP 6 Click Submit All Changes. SPA9000 and phones will reboot.

STEP 7 To verify the operation, use an external phone to make an incoming call. The Auto 
Attendant will answer after the time specified.

NOTE There are additional customization options for the Auto Attendant. For more 
information, see the SPA9000 Voice System Administration Guide.
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Routing Calls to a Receptionist, Extension, or Hunt Group

The SPA9000 Voice System is able to route incoming call to any extension, 
including the receptionist phone, defined in the system.

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click Voice tab > Line 1.

STEP 3 In the Contact List field, enter the extension number of the phone or hunt group 
where you want the calls to be routed. To ring multiple phone simultaneously, type 
a comma between each number.

NOTE For information about how to configure hunt groups or shared extensions, 
see “Managing Inbound Calls with Hunt Groups,” on page109.

STEP 4 Optionally, add call forward information to the Contact List to specify how 
unanswered calls are handled.

NOTE It is useful to add call forward information to ensure that calls are answered 
when the designated phone is unstaffed, as may be the case during lunch 
time or after hours. In this case, if the call is not answered within a specified 
time, the call is routed to another phone or to the Auto Attendant.

a. Add the call forward information to the Contact List field, as shown below:

SYNTAX: <target_extension_number>, cfwd=<forwarded_number>

EXAMPLE: 100, cfwd=102
SPA9000 Voice System Installation and Configuration Guide for Web UI 96



Configuring Phone Service and Voice Mail
Configuring Inbound Call Routing 5

 

b. Modify the Cfwd No Ans Delay parameter, which defines the number of 
seconds that elapse before a call is considered to be unanswered.

EXAMPLE: Incoming calls are routed to the receptionist (extension number 
100). If the receptionist does not answer the call in 15 seconds, the incoming 
call is forwarded to the Auto Attendant.

• Contact list: 100,cfwd=aa

• Cfwd No Ans Delay: 15

STEP 5 Repeat this procedure for all active lines.

STEP 6 Click Submit All Changes. The SPA9000 and the phones reboot.

STEP 7 To verify your progress:

a. Verify that incoming calls are routed directly to the desired extension number. 

b. If you configured a call forward option, verify that the call is forwarded 
correctly after the specified Call Forward No Answer time.

Using Direct Inward Dialing to Phone Extensions

Direct Inward Dialing allows the external users to dial directly any phone extension 
in the SPA9000 Voice System, without passing through the Auto Attendant or the 
receptionist.

Before proceeding with the configuration you need to have the full 
correspondence between the external (DID) number and the extension number.
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NOTE

• Direct Inward Dialing requires network support for SIP trunking DID. 

• It is important that the DID number format match exactly the format of the 
number signaled in the SIP trunk. 

• Please check with your Service Provider to confirm the availability of this 
feature and the correct DID number format, before proceeding with this 
configuration.

SYNTAX: <DIDn1>:+<Extn1> | <DIDn2>:+<Extn2> | 
<DIDn3>:+<Extn3> | <DIDn4>:+<Extn4> | <DIDn5>:+<Extn5> | 
<DIDn6>:+<Extn6> | <DIDn7>:+<Extn7> | <DIDn8>:+<Extn8> | 
<DIDn9>:+<Extn9> | <DIDn10>:+<Extn10> | <DIDn11>:+<Extn11> | 
<DIDn12>:+<Extn12> | <DIDn13>:+<Extn13> | <DIDn14>:+<Extn14> 
| <DIDn15>:+<Extn15> | <DIDn16>:+<Extn16> | <default_route>

• Enter a plus (+) or a minus (-) before the extension number to achieve the 
desired results for caller ID and call routing:

• +<Extn1> The extension will be alerted when there is an incoming call to the 
DID number, and the DID number will be used as the local user-ID in outbound 
SIP requests, along with the display-name of the extension. 

• -<Extn1> The extension will not be alerted when there is an incoming call to 
the DID number. However, the DID number will be used as the local user-ID in 
outbound SIP requests, along with the display-name of the extension. 

• DIDn#: DID number, matching the format of the number signaled in the SIP trunk

• Extn#:  Target extension number or aa for Auto Attendant

• Default route: The default route (extension, hunt group or Auto Attendant) to be 
used in case the incoming target number does not match any of the DID 
numbers in the contact list with the format described in the sections above.

• Call forward: Optionally, add call forward information to the Contact List to 
specify how unanswered calls are handled.
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NOTE It is useful to add call forward information to ensure that calls are answered 
when the designated phone is unstaffed, as may be the case during  lunch 
time or after hours. If the call is not answered within a specified time, it is 
routed to another phone or to the Auto Attendant.

SYNTAX: <DIDn1>:+<Extn1>,cfwd=<target> | 
<DIDn2>:+<Extn2>,cfwd=<target> | 
<DIDn3>:+<Extn3>,cfwd=<target>

EXAMPLE: 4085555550:aa | 4085555551:+101,cfwd=aa | 
4085555552:+102 | 4085555553:+103 | 4085555554:+104 | 
4085555650:+500

STEP 1 Plan the DID-to-extension mapping. Refer to the following example.

STEP 2 Start Internet Explorer, and enter the IP address of the SPA9000.

STEP 3 Click Admin Login, and then click Advanced.

STEP 4 Click Voice tab > Line 1.

STEP 5 Configure the Contact List parameter as described earlier in this section.

STEP 6 If you entered call forwarding in your rule, modify the Cfwd No Ans Delay 
parameter, as needed, to specify the number of seconds that elapse before a call 
is considered to be unanswered.

DID Number Extension Number User

408-555-5550 aa Auto Attendant

408-555-5551 101 User 1

408-555-5552 102 User 2

408-555-5553 103 User 3

408-555-5554 104 User 4

408-555-5650 500 Support (hunt) group
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STEP 7 Repeat this procedure for all active lines.

STEP 8 Click Submit All Changes. The SPA9000 and the phones reboot.

STEP 9 To verify your progress, make an inbound call to the DID number and verify that the 
call is directed to the specified target extension.

You have completed the basic installation and configuration. If you are interested in 
configuring additional advanced features, continue to Chapter 6, “Configuring 
Special Features.”
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Configuring Special Features

This chapter helps you to get started setting up various features that may be 
useful to your customer.

NOTE For complete information about configuring SPA9000 Voice System features, refer 
to the Cisco SPA9000 Administration Guide.

• “Using the Internal Music Source for Music On Hold,” on page101

• “Configuring the SPA932 Sidecar to Work with the SPA9000,” on page103

• “Managing Inbound Calls with Hunt Groups,” on page109

• “Managing Inbound Calls with Shared Line Appearances,” on page113

Using the Internal Music Source for Music On Hold 

The SPA9000 has an internal music source that plays an internally stored music file 
repeatedly. The SPA9000 ships with a default music file (Romance de Amor). 
Follow this procedure to enable the internal music source. 

NOTE For other Music On Hold options, see the Cisco SPA9000 Voice System 
Administration Guide.
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STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click the PBX Status link, near the top right corner of the page. 

The screen lists each phone by Station Name and Extension number.

SPA9000 PBX Status page

STEP 3 Find the phone that you want to configure, and then click the hyperlink in the IP 
Address column. The Telephone Configuration page appears in a separate 
browser window.

STEP 4 Click the Ext 1 tab.

STEP 5 Under Call Feature Settings, find the MOH Server field, and enter: imusic

Telephone Configuration > Ext 1 page: Call Feature Settings section

STEP 6 Click Submit All Changes. 

STEP 7 To verify, place a test call to the extension. When the call is answered and put on 
hold, the caller should hear the default music file (Romance de Amor).

STEP 8 Repeat as needed for each extension on the phone, and for each phone that needs 
music on hold.
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Configuring the SPA932 Sidecar to Work with the SPA9000

The SPA932 is an attendant console, also known as a sidecar, that operates with 
the SPA962 IP phone to allow a user to manage calls and monitor the status of 
other stations. Up to two sidecars can be attached. Each provides up to 32 
programmable buttons for speed dial, busy lamp field (BLF), and call pickup 
features.

NOTE

• All phones that are associated with SPA932 keys must have station names on 
their phone configuration pages. For more information, see “Setting Up Each 
Station” on page_57. In addition, CTI (computer telephone interface) must be 
enabled. For more information, see “Configuring General Settings” on page_45. 

• SPA901, SPA921, SPA941 cannot be monitored for Busy Lamp Function (BLF) 
by the SPA962/SPA932, as these phones do not support CTI.

• Each station can be monitored only by one SPA962/932 at a time.
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STEP 1 To connect the SPA962 and the SPA932 together, complete the following tasks:

a. Turn both the SPA962 and the SPA932 over so that the ports on the back of the 
device are facing up.

b. Align the hole in the SPA962 alignment recess with the hole on the attachment 
arm.

c. Using the attachment arm screw, secure the attachment arm to the SPA962.

d. Using the other attachment arm screw, secure the attachment arm to the 
SPA932.

e. Locate the AUX IN port on the back of the SPA932. Connect one end of the 
auxiliary cable to this port.
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f. Route the auxiliary cable through the cable relief channel.

g. Locate the AUX port on the back of the SPA962. Connect the other end of the 
auxiliary cable to this port.

h. Attach the supplied desktop stand to each unit.

i. To connect another SPA932 unit to the first SPA932, use the supplied 
attachment arms and screws. Connect the auxiliary cable from the AUX OUT 
port of the first unit, to the AUX IN port of the second unit.

STEP 2 Connect a cable from the WAN port of the SPA962 to a port on your switch. The 
display flickers briefly and then the color display appears with the assigned 
extension number.

STEP 3 Use the administration computer to install the latest firmware for the SPA962.

NOTE You can find any available updates at www.cisco.com/go/smallbiz.
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STEP 4 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced. 

NOTE Alternatively, if you know the IP address of the SPA962, you can enter the IP 
address in Internet Explorer, and then skip ahead to Step 7.

STEP 5 Click PBX Status, near the top right corner of the web page.

The screen lists each phone by station name and extension number. 

STEP 6 Find the User ID for the SPA962, and then click the hyperlink in the IP Address 
column. 

The Telephone Configuration page appears in a separate browser window. 

STEP 7 Click the SPA932 tab.

STEP 8 In the Server Type list, select SPA9000.

STEP 9 Under Unit 1, configure each key by using the following syntax:

fnc=type;nme=Name;sub=stationname@$PROXY;ext=extension#
@$PROXYvid=#

OR: fnc=type;nme=Namesub=stationname@SPA9000ipaddress:6060;
ext=extension#@SPA9000ipaddress:6060;vid=#
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Example 1: Busy Lamp Field and Speed Dial: 
fnc=blf+sd;sub=Accounting@$PROXYext=102@$PROXY

Example 2: Busy Lamp Field and Call Pickup: 
fnc=blf+cp;sub=Accounting@$PROXY;ext=102@$PROXY

• fnc (required): The function of this key. The following functions can be used 
independently or in combination. 

• blf: Busy Lamp Field
Indicates the state of the monitored line.

• Green: Idle

• Red: Busy

• Red Fast Blink: Ringing

• Amber: Failed Subscribe (received 4xx response)

• Amber Slow Blink: Undefined (may be no response to subscribe, or BLF not 
specified)

NOTE Busy Lamp Field works only with SPA9x2 series phones, when CTI is 
enabled. SPA9x1 series phones do not support CTI.

• sd: Speed Dial
Allows the user to dial the selected extension quickly, either to place an internal 
call or to perform a blind transfer of an active call.

• cp: Call Pickup (in combination with BLF)
Allows the user to pick up an unanswered call on the selected extension; can 
be used only in combination with blf (cp+blf) 

NOTE For a multi-function key, enter a plus sign (+) between the functions.

• nme (optional): Display name for SPA932 key. It may be overwritten with 
successful SUBSCRIBE. 
SPA9000 Voice System Installation and Configuration Guide for Web UI 107



Configuring Special Features
Configuring the SPA932 Sidecar to Work with the SPA9000 6

 

• sub (required): The station name of the device and the IP address of the 
SPA9000 

NOTE The station name must exactly match the name that is entered in the 
phone configuration web page. The assigned names are displayed on 
the PBX Status page (click the PBX Status link on the main 
administration web page). For more information about entering a 
station name, see “Setting Up Each Station” on page_57. 

• ext (required): The extension number on the specified phone, as in the 
following example: xt=101@$PROXY. Alternatively, you can enter the usr 
parameter with the assigned user ID, as in the following example: 
usr=Smith@$PROXY. 

• vid (optional): Extension ID of the phone lines on the SPA962 (corresponds to 
Ext 1 to 6; valid values, 1-6) 

STEP 10 Click Submit All Changes.

STEP 11 To verify your progress, perform the following tasks:

• Verify that the keys on the SPA932 are shining green. A flashing red light 
indicates a problem with the syntax.

• To test a speed dial key, press the key and verify that the destination phone 
rings. 

• To test a BLF key, place a call from the destination phone and verify that the BLF 
key flashes red on the SPA932.
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Managing Inbound Calls with Hunt Groups

A Hunt Group is a group of client stations that are treated as one extension for the 
purpose of managing inbound calls. The client stations in the hunt group can be 
alerted simultaneously or sequentially. The first client station to pick up the call 
establishes a private connection to the caller. 

NOTE Compare a Shared Line Appearance to a Hunt Group. A Hunt Group may ring 
several stations simultaneously, but only one station can answer and manage the 
call. A Shared Line Appearance also rings multiple lines simultaneously but allows 
multiple stations to share and manage the call. For more information, see “Managing 
Inbound Calls with Shared Line Appearances,” on page113.

Contact List Syntax for Hunt Groups

The hunting process for incoming calls is controlled by the Contact List. The 
Contact List specifies the lines to ring, the order in which to ring them, the duration 
to ring one line before trying another line, and the maximum period to hunt. 

SYNTAX: extension:[name=name,]station[,station[,station 
[…]]],hunt=hrule[,cfwd=target]

• extension: An extension number for the hunt group

• name: A name for the hunt group, which will appear in the Corporate Directory 

• station: The extension numbers; the wildcard symbols ? and * can be used 
to represent one or more characters

• hunt=hrule: The hunt order, ring interval, and maximum duration, in the 
following format: hunt=algo;interval;max

• algo: The hunt order.

- re: Restart. Hunting starts at the beginning of the list. If the first station 
does not answer within the specified interval (see below), the hunt 
proceeds through the stations in sequential order.

- ne: Next. The system determines the station that was chosen in the 
previous hunt, and hunting starts with the next station in the list. If that 
station does not answer within the specified interval (see below), the 
hunt proceeds through the stations in sequential order.
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- ra: Random order. The system randomly chooses a station from the 
list. If the selected station does not answer within the specified 
interval (see below), the hunt proceeds randomly through the 
unchosen stations until each station is tried.

- al: All. The system rings all the stations at the same time.

• interval: The number of seconds to wait for one station to answer, 
before choosing another station. If interval is *, the hunt is stopped at the 
first station that starts ringing, and rings the station until it answers, or the 
caller hangs up, or the station's ringer times out.

• max: The maximum duration of the hunt, either in seconds or cycles. When 
this limit is reached, the call is rejected or is forwarded to the specified call 
forward number (see below).

- If max is greater than interval, it represents the total time in seconds 
to hunt. 

- If max is less than interval, it represents the maximum number of 
times to cycle through the hunt group. If max is 0, hunting continues 
indefinitely until the caller either hangs up or the call is answered. 
Exceptions: This value is ignored if algo = al, or interval = * (but 
it must be present and should be set to 1).

• cfwd=target: If the call is unanswered and the maximum hunting duration 
has been met, the call is forwarded to the specified number. When forwarding 
the call, the SPA8000 sends a 302 response to the ITSP.

NOTE The call forward settings for the individual stations are ignored during 
hunting. Instead, the call forward settings in the Contact List are used.

Contact List Examples for Hunt Groups

• Contacting a group of stations simultaneously

EXAMPLE: 500:name=Sales,hunt=al;101,102,103

This hunt group is assigned an extension number (500). The group is named 
Sales and includes three stations (101,102,103). A call to extension 500 
rings all three stations simultaneously (hunt=al). 
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• Using wildcard characters to specify a range of station numbers

EXAMPLE: 500:name=TechSupport,hunt=al,1*
In this example, the * symbol is a wildcard character that represents any 
number of digits. A call to extension 500 simultaneously rings all stations that 
begins with the number 1.

• Creating multiple hunt groups with the pipe character

EXAMPLE: 500:name=TechSupport,hunt=al,101,102,103| 
600:name=AccountSupport,hunt=al,2*

Two hunt groups are created. A call to extension 500 simultaneously rings 
stations 101, 102, and 103. A call to extension 600 simultaneously rings all 
stations that begin with the number 2. 

• Ringing stations sequentially with call forwarding to the Auto Attendant

EXAMPLE: 300:name=TechSupport,101,102,100,hunt=re;20;2, 
cfwd=aa

This hunt group is assigned an extension number (300) and is named 
TechSupport. The group includes three stations (101,102,100). Calls are 
routed sequentially from the beginning of the list (hunt=re). Every new call is 
routed to the first station, 101. If the call is unanswered, it cycles to station 102 
and then to station 100. Each phone rings for 20 seconds (20). After 2 cycles, 
an unanswered call is forwarded to the Auto Attendant (cfwd=aa). 

• Ringing stations randomly with call forwarding to voice mail

EXAMPLE: 400:name=Sales,101,102,103,hunt=ra;30;1, 
cfwd=vm2100

This hunt group is assigned an extension number (400) and is named Sales. 
The group includes three stations (101,102,103). Calls are routed in random 
order (hunt=ra). A new call is routed to a randomly chosen station. If the call is 
unanswered, it cycles through the stations in random order. Each phone rings 
for 30 seconds (30). After 1 cycle is completed, an unanswered call is 
forwarded to the voice mail for station 100, where Line 2 is configured for the 
voice mail service (1,cfwd=vm2100). 
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• Resuming from a previous hunt with call forwarding to a receptionist

EXAMPLE: 500:name=Scheduling,102,103,101,hunt=ne;45;240, 
cfwd=100

This hunt group is assigned an extension number (500) and is named 
Scheduling. The group includes three stations (102,103,101). Calls are routed 
in “next station” order (hunt=ne). When a new call is received, the system 
resumes the previous hunt. For example, suppose that station 103 answered 
the most recent call to the group. A new call is routed to the next station in the 
list, which is station 101. If the call is unanswered, then it cycles to station 102, 
and so on. Each phone rings for 45 seconds (45;). After a total of 240 seconds 
has elapsed, the call is forwarded to station 100 (240,cfwd=100).

• Multiple Lines with Wildcard Characters

EXAMPLE: 400:name=CustomerService,10?,hunt=re;20;2, 
cfwd=aa|500:name=Sales,20?,hunt=ra;30;1,cfwd=vm100| 
600:name=TechSupport, 300,301,302,hunt=ne;45;3,cfwd=100|

Three hunt groups are created. A call to extension 400 rings stations 100 to 109 
sequentially. A call to extension 500 rings stations 200 to 209 randomly. A call 
to extension 600 resumes the previous hunt.

Creating a Hunt Group

Use the following procedure to create a hunt group.

STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced.

STEP 2 Click Voice tab > SIP.

STEP 3 Scroll down to the PBX Parameters section.

STEP 4 In the Hunt Groups field, type your hunt group rule. See “Contact List Syntax for 
Hunt Groups,” on page109 and “Contact List Examples for Hunt Groups,” on 
page110.

STEP 5 Click Submit All Changes. The phones reboot.

STEP 6 To verify the settings, place a call to the new group line. Verify that the call is 
routed according to the specified settings.
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Managing Inbound Calls with Shared Line Appearances

A shared line appearance (SLA) allows multiple stations to share an extension 
number and to manage a call as a group. 

About Shared Line Appearances

An incoming call to an SLA causes all stations to ring simultaneously. The phones 
display the line status, such as idle, ringing, or busy.

Be aware of the following factors:

• If a shared line is being used by one of the stations in the group, no one can use 
the corresponding line key until the line is released. A message appears on the 
phone display to indicate that a shared call is active.

• All stations with a line key for the SLA can monitor the status based on the 
appearance of the line key button:

• Green: The SLA is available.

• Flashing Red Quickly: A call is ringing the SLA and has not been answered.

• Flashing Red Intermittently: A call is active at another station.

• Flashing Red Slowly: A call is on hold.

• Solid Red: A call is active on this station. 

• All stations with a display can monitor the status of any SLA that is configured. 
The icon next to the line key will change to show ringing, off-hook, or busy "<--
>" until the phone is back on-hook.

• Comparing the SLA to a Hunt Group, both may ring several stations 
simultaneously. However, only one station in a Hunt Group can answer and 
manage the call. For more information, see “Managing Inbound Calls with Hunt 
Groups,” on page109.
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STEP 1 Start Internet Explorer, and then enter the IP address of the SPA9000. Click Admin 
Login and then click Advanced. 

STEP 2 Choose the client station that you want to configure:

a. Click the PBX Status link near the top right corner or lower left corner of the 
page to view the list of client stations.

b. Click the hyperlink in the IP Address column for the first phone that you want to 
configure. The telephone configuration page appears in a separate browser 
window.

STEP 3 Configure the shared extension on the selected station:

a. Click the tab for the extension that you want to configure (Ext 1 ... Ext n, 
depending on the phone model). 

NOTE As a general practice, Cisco recommends that you always reserve 
Extension 1 on the client station as the primary and private extension 
of the designated user. 

b. Scroll down to the Share Line Appearance section, and then enter the 
following settings:

- Share Ext: Choose shared. 

- Shared User ID: Enter a user ID number for this SLA. After the line key is 
configured, this ID will appear on the phone display and in the Corporate 
Directory.

SPA9xx Telephone Configuration > Ext: Shared Line Appearance

c. Scroll down to the Subscriber Information section, and then enter a User ID 
and Display Name for this shared extension.
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SPA9xx Telephone Configuration > Ext: Subscriber Information

d. Scroll down the Proxy and Registration section, and enter the same Proxy 
value as on the primary extension for this station.

SPA9xx Telephone Configuration > Ext: Proxy and Registration

STEP 4 Configure a line key button for the shared extension: 

a. Click the Phone tab.

b. Scroll down to the Line Key area for the line key button that you want to 
configure (Line 1 ... Line n, depending on the phone model). 

c. Enter the following settings to correspond with the entries that you made on 
the Extension tab:

- Extension: From the drop-down list, choose the number corresponding 
to the Ext N tab that you configured for this SLA. For example, if you 
configured the SLA on the Ext 2 page, then choose 2 from the Extension 
drop-down list.

- Shared Call Appearance: From the drop-down list, choose shared.

- Short Name: Type the extension number that you entered as the Shared 
User ID for the extension. This extension number will appear on the 
phone display and in the Corporate Directory.

SPA9xx Telephone Configuration: Ext: Line Key
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STEP 5 If needed, configure additional line keys for the same SLA. 

STEP 6 Click Submit All Changes.

STEP 7 Repeat this procedure for each phone that you want to configure with the SLA.
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Localization

This chapter explains how to localize your SPA9000 Voice System with the 
language files, tones, and ring patterns for your region.

• “Localizing the SPA9000 Auto Attendant Prompts,” on page117

• “Local Time Configuration,” on page120

• “Configuring the SPA9000 and SPA9xx Call Progress Tones,” on page120

• “Localizing the SPA400 Voice Mail Prompts,” on page126

• “Localizing the SPA400 Call Disconnect Tones,” on page127

• “Localizing the SPA400 Caller ID Method,” on page129

NOTE For instructions about localizing the phone display, see the SPA9x2 Phone 
Administration Guide.

Localizing the SPA9000 Auto Attendant Prompts

The default Auto Attendant prompts are in English. You can localize your system by 
downloading and installing the appropriate language files for your region. Store 
these prompts on a TFTP/HTTP/HTTPS server, and the SPA9000 will download 
the files at the device boot up time.

NOTE You need TFTP server software to localize the SPA9000.
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The set of files includes the following types of prompts:

• Prompt 1: Greets the caller and prompts for an extension number

• Prompt 2: Notifies the caller that the call is being forwarded

• Prompt 3: Notifies the caller of an invalid extension

• Prompt 4: Good-bye

• Prompt 5: Greets the caller with specific prompts for General Information, 
Sales, and Support.

• Prompt 6: Notifies the caller that the office is currently closed and prompts for 
an extension number.

NOTE The Auto Attendant prompt files must be encoded in G.711u and must have a total 
file size (message and header) of 94.5 seconds or less. 

STEP 1 Download the SPA9000 Auto Attendant prompts from Cisco Partner Central, Voice 
& Conferencing page, Technical Resources section, using the following URL: 
www.cisco.com/web/partners/sell/smb/products/
voice_and_conferencing.html#~vc_technical_resources.

STEP 2 Store the downloaded files on a TFTP/HTTP/HTTPS server.

STEP 3 To configure the SPA9000 to download the files from the server, complete the 
following tasks:

a. Start Internet Explorer, and then enter the IP address of the SPA9000. Click 
Admin Login and then click Advanced. 

b. Click Voice tab > the SIP tab.

c. Scroll down to the Auto Attendant Parameters area of the page.

d. In the AA Prompts URL field, enter the script for the server, path, and prompt 
file names.

SYNTAX: 

serv=scheme://server_addr[:port]/root_path;[p1={prompt1 
file path name};][p2={prompt2 file path 
name};][p3={prompt3 file path name};][p4={prompt4 file 
path name};][p5={prompt5 file path name};][p6={prompt6 
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file path name};][p7={prompt7 file path 
name};][p8={prompt8 file path name};][p9={prompt9 file 
path name};][p10={prompt10 file path name};]

• scheme: Enter one of the following values: tftp, http, or https.

• port: The default ports are 69 for tftp, 80 for http, and 443 for https.

• root_path can be empty.

• [ ] denotes an optional item.

• If the prompt file name is none, the corresponding prompt currently saved 
in the flash is erased. 

EXAMPLE:

serv=tftp://192.168.2.150/root/test/;p1=fr_1.wav; 
p2=fr_2.wav;p3=fr_3.wav;p4=none;  

STEP 4 Click Submit All Changes.

The prompts are downloaded when the SPA9000 boots up. If a prompt has 
already been downloaded from the given URL, the download is not performed. 

STEP 5 To verify that the prompts are localized, make a call to the Auto Attendant. From an 
internal phone, you can press the Setup button, then press 1 - Directory, then 2 - 
Corporate Directory, and then scroll down to find and select the number for the 
Auto Attendant.
SPA9000 Voice System Installation and Configuration Guide for Web UI 119



Localization
Local Time Configuration 7

 

Local Time Configuration

You will need to localize the date, time, and daylight saving time rule. See “Setting 
the Date and Time,” on page 30 and “Configuring Daylight Saving Time,” on 
page 31. Use the following table to find the correct Daylight Saving Time Rules for 
EMEA and Australia.

Table 1 SPA9000 Daylight Saving Time Rules

Configuring the SPA9000 and SPA9xx Call Progress Tones

Call progress tones, such as dial tone and reorder, indicate the call progress to the 
users. You can configure your SPA9000 and your SPA9xx phones to use the 
appropriate call progress tones for your region.

STEP 1 Localize the tones for the SPA9000:

a. Start Internet Explorer, and then enter the IP address of the SPA9000. Click 
Admin Login and then click Advanced.

b. Click Voice tab > Regional. 

c. In the Call Progress Tones section, enter the values from Table 3-1 into the 
corresponding fields. 

d. Click Submit All Changes.

Country Daylight Saving Time Rule Time Zone

Australia (ACST) start=4/1/7/3;end=10/1/7/2;save=-1 GMT+10:30

Australia (AEST) start=4/1/7/3;end=10/1/7/2;save=-1 GMT+11

Australia (AWST) start=3/-1/7/3;end=10/-1/7/2;save=¬1 GMT+09:00

France start=3/-1/7/2;end=10/-1/7/2;save=1 GMT+1

Germany start=3/-1/7/2;end=10/-1/7/2;save=1 GMT+1

Spain start=3/-1/7/2;end=10/-1/7/2;save=1 GMT+1

UK/Ireland start=3/-1/7/2;end=10/-1/7/2;save=1 GMT
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STEP 2 Localize the tones for the phones:

a. Click the PBX Status link. 

b. Find the phone that you want to configure, and then click the hyperlink in the IP 
Address column.

c. Click Regional.

d. In the Call Progress Tones section, enter the values from Table 2, ‘SPA9000 Call 
Progress Tones by Country,” on page121. 

e. Click Submit All Changes.

f. Repeat this step as needed for each phone.

Table 2 SPA9000 Call Progress Tones by Country 

 

Australia

Dial Tone 400@-19,425@-19;10(*/0/1+2)

Outside Dial Tone 420@-16;10(*/0/1)

Prompt Tone 520@-19,620@-19;10(*/0/1+ 2)

Reorder Tone 425@-19;*(2.5/.5)

Off Hook Warning Tone 480@-10,620@0;10(.125/.125/1+2)

Ring Back Tone 400@-19,425@-19;*(.4/.2/1+2,.4/2/1+2)

Busy Tone 425@-16;10(.375/.375/1)

Call Waiting Tone 400@-20;30(0.1/2/1)

Confirm Tone 600@-16;1(.25/.25/1)

Denmark

Dial Tone 425@-10;*(*/0/1)

Outside Dial Tone 425@-16;10(*/0/1)

Prompt Tone 425@-19,620@-19;*(*/0/1+2)

Reorder Tone 425@-10;*(0.25/0.25/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)
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Ring Back Tone 425@-10;*(1/4/1)

Busy Tone 425@-10;10(0.25/0.25/1)

Call Waiting Tone 425@-20;30(0.2/0.2/1,0.2/3.6/1,0.2/0.2/1,0.2/0/1)

Confirm Tone 425@-16;1(.25/.25/1)

France

Dial Tone 440@-10;*(*/0/1)

Outside Dial Tone 440@-16;10(*/0/1)

Prompt Tone 440@-19,620@-19;*(*/0/1+2)

Reorder Tone 440@-10;*(.5/.5/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)

Ring Back Tone 440@-10;*(1.5/3.5/1)

Busy Tone 440@-10;10(.5/.5/1)

Call Waiting Tone 440@-20;30(.175/.175/1,.175/3.5/1)

Confirm Tone 440@-16;1(.25/.25/1)

Germany

Dial Tone 425@-10;10(*/0/1)

Outside Dial Tone 425@-13,400@-13;10(*/0/1+2)

Prompt Tone 440@-19,620@-19;30(*/0/1+2)

Reorder Tone 440@-10;*(.5/.5/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)

Ring Back Tone 440@-10;10(1.5/3.5/1)

Busy Tone 425@-10;10(0.48/0.48/1)

Call Waiting Tone 425@-20;30(0.2/0.2/1,0.2/5/1)

Confirm Tone 440@-16;1(.25/.25/1)

Ireland

Dial Tone 400@-10;*(*/0/1)

Outside Dial Tone 425@-16;10(*/0/1)
SPA9000 Voice System Installation and Configuration Guide for Web UI 122



Localization
Configuring the SPA9000 and SPA9xx Call Progress Tones 7

 

Prompt Tone 425@-19,620@-19;*(*/0/1+2)

Reorder Tone 425@-10;*(0.25/0.25/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)

Ring Back Tone 425@-10;(0.4/0.2/1,0.4/2/1)

Busy Tone 425@-10;10(0.5/0.5/1)

Call Waiting Tone 425@-20;30(0.18/0.2/1,0.2/4.5/1)

Confirm Tone 425@-16;1(.25/.25/1)

Italy

Dial Tone 425@-10;*(0.2/0.2/1,0.6/1/1)

Outside Dial Tone 425@-16;10(0.2/0.2/1,0.6/1/1)

Prompt Tone 425@-19,620@-19;*(*/0/1+2)

Reorder Tone 425@-10;*(0.2/0.2/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)

Ring Back Tone 425@-10;*(1/4/1)

Busy Tone 425@-10;10(0.5/0.5/1)

Call Waiting Tone 425@-20;30(0.4/0.1/1,0.25/0.1/1,0.15/14/1)

Confirm Tone 425@-16;1(.25/.25/1)

Netherlands

Dial Tone 425@-10;*(*/0/1)

Outside Dial Tone 425@-16;10(*/0/1)

Prompt Tone 425@-19,620@-19;*(*/0/1+2)

Reorder Tone 425@-10;*(0.25/0.25/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)

Ring Back Tone 425@-10;*(1/4/1)

Busy Tone 425@-10;10(.5/.5/1)

Call Waiting Tone 425@-20;30(0.5/9.5/1)

Confirm Tone 425@-16;1(.25/.25/1)
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Norway

Dial Tone 425@-10;*(*/0/1)

Outside Dial Tone 425@-16;10(*/0/1)

Prompt Tone 425@-19,620@-19;*(*/0/1+2)

Reorder Tone 425@-10;*(0.2/0.2/1)

Off Hook Warning Tone 1400@-10;*(0.4/15/1)

Ring Back Tone 425@-10;(1/4/1)

Busy Tone 425@-10;10(.5/.5/1)

Call Waiting Tone 425@-20;30(0.2/0.6/1,0.2/10/1)

Confirm Tone 1400@-16;1(20/0/1)

Portugal

Dial Tone 425@-10;*(*/0/1)

Outside Dial Tone 425@-16;10(*/0/1)

Prompt Tone 425@-19,620@-19;*(*/0/1+2)

Reorder Tone 425@-10;*(.2/.2/1,.2/.2/1,.2/.6/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)

Ring Back Tone 425@-10;*(1/5/1)

Busy Tone 425@-10;10(.5/.5/1)

Call Waiting Tone 425@-20;30(0.2/0.2/1,0.2/5/1)

Confirm Tone 425@-16;1(.25/.25/1)

Spain

Dial Tone 425@-10;*(*/0/1)

Outside Dial Tone 425@-16;10(*/0/1)

Prompt Tone 425@-19,620@-19;*(*/0/1+2)

Reorder Tone 425@-10;*(.2/.2/1,.2/.2/1,.2/.6/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)

Ring Back Tone 425@-10;*(1.5/3/1)
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Busy Tone 425@-10;10(.2/.2/1)

Call Waiting Tone 425@-20;30(.175/.175/1,.175/3.5/1)

Confirm Tone 425@-16;1(.25/.25/1)

Sweden

Dial Tone 425@-10;*(*/0/1)

Outside Dial Tone 425@-16;10(*/0/1)

Prompt Tone 425@-19,620@-19;*(*/0/1+2)

Reorder Tone 425@-10;*(0.25/0.75/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)

Ring Back Tone 425@-10;*(1/5/1)

Busy Tone 425@-10;10(0.25/0.25/1)

Call Waiting Tone 425@-20;30(0.5/9.5/1)

Confirm Tone 425@-16;1(.25/.25/1)

UK

Dial Tone 350@-10;440@-10;*(*/0/1+2)

Outside Dial Tone 425@-16;10(*/0/1)

Prompt Tone 400@-19,620@-19;*(*/0/1+2)

Reorder Tone 400@-10;*(0.4/0.35/1,0.225/0.525/1)

Off Hook Warning Tone 425@-10;*(.2/.2/1,.2/.6/1)

Ring Back Tone 400@-10;(0.4/0.2/1,0.4/2/1)

Busy Tone 400@-10;10(0.375/0.375/1)

Call Waiting Tone 400@-20;30(0.1/2/1)

Confirm Tone 400@-16;1(20/0/1)
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Localizing the SPA400 Voice Mail Prompts

By default, the voice mail system is configured for the English language. You can 
localize the system by downloading and installing the appropriate language files 
for your region.

STEP 1 Download the necessary language files from Cisco Partner Central, Voice & 
Conferencing page, Technical Resources section, using the following URL: 
www.cisco.com/web/partners/sell/smb/products/
voice_and_conferencing.html#~vc_technical_resources.

STEP 2 To extract the files, complete the following tasks:

a. Use WinZip to open the sounds.zip file.

b. Click Extract on WinZip toolbar.

c. Select the Desktop or other temporary destination, select the Use folder 
names check box, and then click Extract.

A progress bar appears as the files are extracted. The Sounds folder 
appears in the selected location. 

STEP 3 To move the files to the SPA400 USB drive, complete the following tasks:

a. Power off the SPA400 by removing the power cord, and then remove the USB 
drive.

b. Insert the SPA400 USB drive into a USB port on the PC where you extracted 
the files.

c. When the USB Disk window appears, click Open folder to view files using 
Windows Explorer, and then click OK. The USB drive contains the spa400vm 
folder. 

NOTE If the USB Disk window does not appear, use Windows Explorer to 
navigate to the USB disk drive (usually Drive E).

d. Open spa400vm\var\lib. The window displays the lib contents, including the 
sounds folder.
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e. If desired, make a backup copy of the existing sounds folder.

NOTE You are not overwriting any user message files in this procedure. 
However, it is a good practice to make a backup copy of your files 
before doing any upgrades.

f. Move the new sounds folder into spa400vm\var\lib on the USB drive. When the 
Confirm Folder Replace window appears, click Yes to All.

g. Remove the USB drive from the PC and insert it into the SPA400.

h. Power on the SPA400. 

STEP 4 Place a test call to the voice mail system to confirm that the new language 
prompts are used.

Localizing the SPA400 Call Disconnect Tones 

One important aspect of VoIP-PSTN integration is the Call Disconnect operation. 
This operation allows the gateway to detect that the call has been terminated on 
the other end, so the local line hangs up automatically. Detecting the tone cadence 
of the Call Disconnect signal is a trigger for closing the loop.

Each country has its own Call Disconnect Signal tone which needs to be 
configured on the SPA400 Tone page. See Table 3, ‘SPA400 Call Processing 
Tones,” on page127.

Table 3 SPA400 Call Processing Tones

Country First Tone 2nd 
(optional)

3rd 
(optional)

4th 
(optional)

Repeat 
Count

On 
(ms)

Off 
(ms)

On 
(ms)

Off 
(ms)

On 
(ms)

Off 
(ms)

On 
(ms)

Off 
(ms)

Australia 360 385 360 385 5

Denmark 430 465 430 270 1

France 490 510 1
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STEP 1 Start Internet Explorer, enter the IP address of the SPA400, and log on.

STEP 2 Click the Tone tab.

SPA400 Tone page

STEP 3 Enter the appropriate settings for your country, as listed in Table 3, ‘SPA400 Call 
Processing Tones.

Germany 230 270 1

Ireland 490 510 1

Italy 190 210 1

Netherlands 180 330 180 330 2

Norway 190 210 1

Portugal 190 210 1

Spain 190 210 190 210 200 600 2

Sweden 250 750 1

UK 400 350 225 525 2

Country First Tone 2nd 
(optional)

3rd 
(optional)

4th 
(optional)

Repeat 
Count

On 
(ms)

Off 
(ms)

On 
(ms)

Off 
(ms)

On 
(ms)

Off 
(ms)

On 
(ms)

Off 
(ms)
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STEP 4 Click Save Settings.

STEP 5 On the menu, click Setup > Voice.

STEP 6 Scroll down to the Tear Down FXO Port field, and enter 0. Refer to the following 
illustration.

SPA400 Setup tab > Voice page: Line Settings section 

STEP 7 Click Save Settings. 

STEP 8 To restart the SPA400, complete the following steps:

a. Click Administration > Reboot.

b. Click the Restart System button. 

c. When the confirmation message appears, click OK. The SPA400 reboots. 

d. When the Reboot OK. Go to Setup page? message appears, click OK.

Localizing the SPA400 Caller ID Method

You need to identify the caller ID method to use in your country.

STEP 1 Click Setup tab > Voice. 

STEP 2 Scroll down to the Line Settings section.

STEP 3 From the Caller Id and CP Tone Method drop-down list, choose your region.

SPA400 Setup tab > Voice page
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NOTE In the United Kingdom, choose UK BT or UK CCA. In the rest of Europe, 
choose European (FSK).

STEP 4 Click Save Settings. 

STEP 5  To restart the SPA400, complete the following tasks:

a. Click Administration > Reboot.

b. Click the Restart button. 

c. When the confirmation message appears, click OK. The SPA400 reboots. 

d. When the Reboot OK message appears, click OK.

STEP 6 To verify your progress, make a call from outside to any of the PSTN lines 
connected to the SPA400 (make sure that CID is enable in your PSTN line). In the 
ringing SPA phone display you should now be able to see the number from the 
calling number.
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Installation Workbook

This workbook is intended to help you to record information about the customer’s 
network environment as well as the order and service information, before installing 
the SPA9000 Voice System. By using this workbook, you can minimize the 
installation time and ensure that all setup requirements are met. 

This workbook is designed to help SPA9000 Voice System installation technicians 
and can be used as a training guide and checklist for VARs and Service Providers.

Customer Information

Company Name

Contact Name – Commercial

Contact Phone Number – 
Commercial

Contact Email Address 
- Commercial

Alternate Contact Phone Number

Contact Name – IT Responsible

Contact Phone Number 
– IT Responsible

Contact email address 
– IT Responsible

Installation Location
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Site Survey

Service Provider Information  

If you have multiple service providers, copy this page as needed. You can configure the four SPA9000 
interfaces with different service providers.

City and Postal Code

Site Survey Date and 
Method (circle one)

Date: 

ON SITE / BY PHONE

Installation Schedule Date

Survey date

Survey by

Service Provider Name

Service Provider Contact 
Information

Service Order Number

Service Activation Date

Service Order Type
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Provisioning Information

SIP Proxy

User Name

Password

Provisioning Method (Circle one.) SPA9000 VOICE SYSTEM WIZARD VERSION 

WEB UI

REMOTE PROVISIONING

Service provider additional 
parameters (e.g. DID numbers)

Audio preferred codec (Circle 
one.)

G.711A G.711u G.729a G.726 G.723.1
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Telephony System Survey

Number of IP Phones to install

Is it there an existing KTS or PBX 
to replace (Circle one.)

YES  / NO

If yes, please list the existing 
features provided by the system

Is the customer setup requiring 
any of the following features? 
(Circle all that apply.)

Receptionist telephone

Automatic attendant

Direct Inward Dialing

Voice mail

Other (please specify):
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Infrastructure Survey

New Cable wiring required 
(Circle one.)

YES  / NO

If yes, how many and where?

AC Outlet available for each 
Cisco SPA device location (Circle 
one.)

YES  / NO

If no, where are the missing 
locations?

PSTN Line (Circle one.) YES  / NO

If yes, how many?

ISDN BRI Line (Circle one.) YES  / NO

If yes, how many?

Battery backup (Circle one.) YES  / NO

If yes, what devices are 
covered?

Fax Machine (Circle one.) YES  / NO

If yes, is there a telephone cable 
available from SPA9000 to the 
fax machine?

YES  / NO
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Broadband Type

Bandwidth

Broadband connection type 
(Circle one.)

T1  / ADSL  / xDSL  / FTTH  / Other

If other please specify:

IP addressing type (Circle one.) DYNAMIC  / STATIC

If static, IP address

If static, network mask

Primary DNS  

Secondary DNS  

Bandwidth Uplink (kbps): 

Downlink (kbps): 

Codec Bandwidth per 
conversation

G.711 – 110 kbps, G.723 – 12.6 kbps, G.726 – 87 to 63 kpbs, G.729 – 
55 kbps

Minimum bandwidth requirement 
(including Internet access and 
VoIP) calculation
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LAN

Gateway LAN IP Address

Network Mask

DNS

DHCP Server YES  / NO

NAT YES  / NO

QoS Router (Circle one.) YES  /   NO

If yes, Type of QoS enforcement 
(Circle one.)

IP TOS  / VLAN ID  / 802.1p

QoS Switch YES  / NO

If yes, Type of QoS enforcement 
(Circle one.)

IP TOS  / VLAN ID  / 802.1p

VLAN tagging (Circle one.) YES  / NO

If yes, Voice VLAN ID

If yes, Data VLAN ID

Power over Ethernet YES  / NO

If yes, how many ports available

Total number of ports on switch

WiFi Network (Circle one.) YES  / NO

If yes, SSID

If yes, encryption type (Circle 
one.)

WEP  / WPA  / WPA2
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New LAN Device(s) needed YES  / NO

If yes, define the type

Sufficient Ethernet ports for each 
IP phone location

YES  / NO

If no, what type of new device 
added

Firewall YES  / NO

If yes, Hardware or Software 
based

Hardware  / Software

Is a specific port need to be 
opened

YES  / NO         Port Number:

If yes, does the customer have 
the administrative access

YES  / NO

AC Outlet availability for each 
installing component

SPA9000 YES  / NO

SPA400 – 1 YES  / NO

SPA400 – 2 YES  / NO

SPA400 – 3 YES  / NO

SPA400 – 4 YES  / NO

IP Phone 1 YES  / NO

IP Phone 2 YES  / NO

IP Phone 3 YES  / NO

IP Phone 4 YES  / NO
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IP Phone 5 YES  / NO

IP Phone 6 YES  / NO

IP Phone 7 YES  / NO

IP Phone 8 YES  / NO

IP Phone 9 YES  / NO

IP Phone 10 YES  / NO

IP Phone 11 YES  / NO

IP Phone 12 YES  / NO

IP Phone 13 YES  / NO

IP Phone 14 YES  / NO

IP Phone 15 YES  / NO

IP Phone 16 YES  / NO

Component YES  / NO

Component YES  / NO

Component YES  / NO

Component YES  / NO

Component YES  / NO

Component YES  / NO

Component YES  / NO
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Cisco SPA devices

Are office junction boxes 
accurately labeled between the 
telco closet and the installation 
locations?

YES  / NO

Is there room in the existing 
equipment rack for additional 
equipment

YES  / NO

SPA9000

Firmware version

SPA901

Number of phones

Firmware version

SPA921

Number of phones

Firmware version

SPA941

Number of phones

Firmware version

SPA922

Number of phones

Firmware version
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SPA9000 Voice System Configuration

SPA9000

SPA942

Number of phones

Firmware version

SPA962

Number of phones

Firmware version

SPA932

Number of consoles

SPA400

Number of gateways

Firmware version

POES5 Number of units

WBP54G Number of units

MB100 Number of units

MAC ID Key Upgrade (opt) VM

NOTES: 
SPA9000 Voice System Installation and Configuration Guide for Web UI 141



Installation Workbook A
 

SPA400 #1

SPA400 #2

SPA400 #3

SPA400 #4

MAC ID PSTN Phone Numbers VM

NOTES: 

MAC ID PSTN Phone Numbers VM

NOTES: 

MAC ID PSTN Phone Numbers VM

NOTES: 

MAC ID PSTN Phone Numbers VM

NOTES: 
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Phone : (enter station number)

Copy and print this page as needed for each phone.

Link

Phone Model

MAC ID

DID Numbers

WiFi  / POE

L1 EXT Share / Private Hunt Group Voice Mail

L2 EXT Share / Private Hunt Group Voice Mail

L3 EXT Share / Private Hunt Group Voice Mail

L4 EXT Share / Private Hunt Group Voice Mail

L5 EXT Share / Private Hunt Group Voice Mail

L6 EXT Share / Private Hunt Group Voice Mail
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Additional Equipment

Equipment Type

Model

MAC Address

Notes

Equipment Type

Model

MAC Address

Notes

Equipment Type

Model

MAC Address

Notes

Equipment Type

Model

MAC Address

Notes
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Additional Installation and Configuration Notes
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Troubleshooting

This appendix provides solutions to problems that may occur during the 
installation and operation of the SPA9000 Voice System. If you can’t find an 
answer here, visit www.cisco.com/web/partners/sell/smb/.

Q. The SPA9000 did not automatically assign an extension number to the 
Cisco SPA IP Phone, and the phone Ext LED is yellow instead of green.

A. The yellow LED indicates that the phone and the SPA9000 are not in 
communication with each other, possibly due to an IP address change or physical 
network problems. 

As a test, reboot the SPA9000, and observe the phone displays to determine if the 
phones are rebooting as expected. If a phone does not reboot, there is a network 
connectivity issue between the phone and the SPA9000. 

Troubleshoot as follows:

• Network environment: Determine if there have been any changes in the 
network environment that would affect the LAN or VLAN on which the 
SPA9000 Voice System equipment resides. The SPA9000 Voice System is a 
LAN-based solution which requires all of the equipment to reside on the same 
VLAN. Changing the network environment may cause the phones to lose 
connectivity with the SPA9000.

• Multicast address settings: To determine if there is a problem with the 
multicast address on the phone configuration, complete the following tasks:

1. To determine the correct multicast address of the SPA9000, connect an 
analog phone to the SPA9000. Lift the receiver and press **** to access the 
IVR. Then press 80# to hear the SPA9000 multicast address and port. 

NOTE Alternatively, connect to the SPA9000 administration web server. Go 
to Voice > SIP page, PBX Parameters section, and find the address in 
the Multicast Address field.
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2. Check the multicast address settings on the phone:

- SPA901: Lift the receiver, and press **** to access the IVR. After the 
greeting plays, press 180# to hear the multicast address. 

If the announced address or port does not match that of the SPA9000, 
then press 181#, and enter the correct address and port, as described 
below. 

– Press the * (star) key after each set of digits in the IP address and 
before the port number; for example, 224*168*168*169*8089. 

– Press the # (pound) key to indicate that you have finished your input. 

– Press 1 to save the setting. The settings take effect after you hang up 
the telephone. The phone may reboot at this time.

- Other SPA phones: Press the Setup button, scroll down to 9 - Network 
and press select. Scroll down to view the Multicast Address.

If the address or port does not match that of the SPA9000, press edit, 
and enter the correct address and port. Then press ok. Restart the 
phone.

• Proxy address settings: To determine if there is a problem with proxy address 
settings, complete the following tasks.

1. To determine the correct proxy listen port of the SPA9000, start Internet 
Explorer, and then enter the IP address of the SPA9000. Click Admin Login 
and then click Advanced. View the Voice > SIP page, PBX Parameters 
section, Proxy List Port field.

2. On the phone, press the Setup button, and scroll down to 9 - Network.  
Select 15 - Multicast Address. 

3. If the address is incorrect, press edit, enter the correct address, and then 
press ok.

Q. When the phones boot up, the LEDs flash yellow for several seconds and 
then turn green.

A. This behavior indicates that the switch is performing spanning tree functions, 
which may interfere with VoIP performance. For proper performance, both 
spanning tree and Port Fast should be enabled on the switch. For instructions 
about configuring these settings on the SLM224P, see “Enabling Spanning Tree 
and Port Fast on the SLM224P Switch,” on page 43. After you enable Port Fast, the 
phone LEDs should no longer flash yellow after a reboot.
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Q. I am using the SPA400 for voice mail but am having trouble retrieving mes-
sages from a phone. When I press the Message button on the phone, I am 
prompted to enter a mailbox number, or I get a busy tone.

A. If the station is properly configured, you should be prompted for a password 
when you press the Message button.  The other responses are caused by the 
following issues: 

• Mailbox not assigned to the phone: If you are prompted to enter a mailbox 
number, a mailbox is not assigned to the phone. Review the settings on the 
SPA400 Voice mail User page to determine which mailboxes are configured. 
Next, check the Telephone Configuration > Ext 1 page, Call Feature Settings 
section. Make sure that the Mailbox ID field displays the correct line interface 
number for the SPA400 as well as a valid mailbox number; for example, 2102 
(line interface 2, mailbox number 102). For more information, see   “Configuring 
the Voice Mail Server and Voice Mail Users,” on page 82) and “Setting Up Each 
Station,” on page 84, in this guide.

• USB drive issues or line interface issues: A busy tone indicates a problem with 
the configuration. Verify that the USB drive is properly inserted into the 
SPA400. Verify that the correct data was entered on the Line 2 configuration 
page (see ““Configuring SPA9000 Connectivity with the SPA400 for PSTN and 
Voice Mail Service,” on page 70).  

Q. When a call comes into a Shared Line Appearance, only one phone rings. 

A. Make sure that the SLA is configured properly on each phone. You must 
configure the information the Ext N page and on the Phone page for each phone. 
Review the step-by-step instructions in “Managing Inbound Calls with Shared Line 
Appearances,” on page113.

Q. I am trying to upgrade a phone with a PC that is connected to the PC port. 
The upgrade is not successful.

A. You cannot perform a firmware upgrade from a PC that is connected to the 
phone that you are upgrading. The phone reboots several times during the 
upgrade process, and as a result the firmware cannot be retrieved from the 
computer. Unplug the PC from the phone and instead connect it to an available 
port on the switch.

Q. I manually entered the proxy address into my phone configuration but it 
doesn’t register with the SPA9000.

A. Verify that you entered the correct SPA9000 IP address and the correct proxy 
listen port (default 6060). For example, enter 192.168.0.1:6060 in the Proxy location 
of the SPA941.
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Q. Why can’t I register the FXS ports to an outside proxy? 

A. The FXS ports are registered directly with the SPA9000; no options exists for it 
to connect to another proxy. 

Q. Why do only four SPA900 series clients register? 

If you need to add more than four phones, install the SPA9000 firmware version 
5.2.5, which supports up to 16 IP phones. 

Q. The IP phone can make internal calls to other IP phones and analog phones 
but it cannot make external calls.

• If this is a new installation with no successful outbound calls: Check to see 
whether the SPA9000 line interface is registered. Follow these steps:

a. Start Internet Explorer, and then enter the IP address of the SPA9000. Click 
Admin Login and then click Advanced.

b. Click Voice tab > Info.

c. Scroll down to the Line N Status section, where N is the number of the line 
interface. 

d. Verify that the Registration State is Registered.

e. If the line interface is not registered, then click the Line N tab and enter the 
correct User ID, Proxy, and Password supplied by your Internet Telephony 
Service Provider (ITSP).

f. Click Submit All Changes.

• If outbound calls previously were placed successfully: First determine whether 
or not the dialed digits are accepted by the dial plan. If the problem is not with 
the dial plan, consider the following possible causes:

• FXO lines: The PSTN central office connection might be disconnected or 
disabled on the PSTN side. Connect an analog phone or a test set directly 
to the FXO line to see if it can get dial tone.

• ITSP service: The network connection could be down.  See if you can 
browse to an external web site such as www.cisco.com/web/partners/sell/
smb/. The ITSP network (Softswitch or Gateway) could be out of service. 
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Q. My SPA9000 is behind a NAT device or firewall and I’m unable to make a 
call or I’m only receiving a one-way connection. What should I do?

A. This problem is caused by problems with NAT mapping. There are various 
methods for resolving the problem. For a brief overview, see “NAT Mapping,” on 
page 37. For instructions, see the Cisco SPA9000 Voice System Administration 
Guide.

Q. When an outside line calls the SPA9000, it rings one time and then goes to 
the Auto Attendant.

A. By default, if no one answers the call after 12 seconds, then the call goes to the 
Auto Attendant. To change this setting, follow these steps:

1. Start Internet Explorer, and then enter the IP address of the SPA9000. Click 
Admin Login and then click Advanced.

2. Click Voice tab > SIP. 

3. Scroll down to the Auto Attendant Parameters section.

NOTE To allow more time for your staff to answer the phone, enter a higher 
number of seconds in the appropriate Answer Delay setting 
(DayTime, NightTime, or Weekends/Holidays).

Alternatively, change the Contact List to route the inbound calls to 
another number or group of numbers. See “Routing Calls to a 
Receptionist, Extension, or Hunt Group,” on page 96.

4. Click Submit All Changes.

Q. How can I change greetings for the Auto Attendant?

A. You can record greetings by using the SPA9000 IVR. You also can specify a 
TFTP server from which recordings can be downloaded by the SPA9000. For 
more information, see the Cisco SPA9000 Voice System Administration Guide.

Q. When I try to connect to voice mail from an external phone, the call does 
not connect.

A. Make sure that you have properly configured your remote access settings (see 
“Enabling Remote Voice Mail Access (Optional),” on page 88). Also check the 
Bridge Mode settings. On the Voice > Line N page, Proxy and Registration section, 
make sure that the VMSP Bridge, XFER Bridge Mode, and CFWD Bridge Mode 
fields are set to all.
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Q. I try to dial a number but I hear a reorder (fast busy) tone.

A. This behavior indicates that the dialed digits are not accepted by the dial plan. 
The Cisco SPA9000 Voice System Administration Guide includes instructions for 
modifying the default dial plan to accommodate various dialing scenarios. To 
better understand the problem, try dialing the number again, but press the digits 
somewhat more slowly than you would normally dial. With a slower input, you can 
determine at what point the tone occurs, and you can adjust the dial plan 
accordingly.

• If the reorder tone occurs immediately after the first digit, then the dial plan 
does not allow that digit in the first position. 

• If the reorder tone occurs after you dial an extension number, your dial plan may 
not allow a number in that sequence, or may require a longer or shorter 
sequence. 

• If the reorder tone occurs after you dial a 7-digit or 9-digit telephone number, 
check the display to see if you dialed the required steering digit before 
entering the number.

• If you dialed a long-distance number and you hear a recording such as “The 
number you dialed is incorrect, please try again,” then the dialed sequence is 
not being accepted by the service provider. You need to check with the service 
provider to find out what digits are required for long-distance dialing. For 
example, is a 1 required at the beginning of the string or should the number  1 
be omitted?

For detailed instructions, see the Cisco SPA9000 Voice System Administration 
Guide.

Q. I placed a test call from an external number, and I heard a busy tone, or my 
call was connected to the wrong extension number.

There are three possible causes to consider:

• Line Registration: Verify that the line is registered. On the SPA9000 Voice > Info 
page, scroll down to the Line N Status section, where N is the number of the 
line interface. Verify that the Status is Registered. If it is not, review your entries 
on the Voice > Line N page to ensure that the correct information is entered. 
After making a change, you may need to refresh your browser a few times 
before the new status appears, to allow time to receive a response from the 
service provider.
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• Contact List: If the line is registered, then the described behavior suggests that 
the Contact List is not working as you expected. The busy tone occurs if the 
Contact List includes a number that is not configured on the system. The 
unexpected call routing typically is caused by an incorrect entry in the Contact 
List (for example, you entered 101 but intended the call to go to 111). You need 
to correct the Contact List to route the incoming calls as desired. For detailed 
instructions, see the Cisco SPA9000 Voice System Administration Guide.

• Connectivity: If the line is registered and the Contact List is correct, there may 
be a connectivity issue between the target phone and the SPA9000. 
Sometimes a phone will have green LEDs even after it has lost connectivity. As 
a test, reboot the SPA9000 and watch the phone display for the phone in 
question.  If the phone does not reboot, then there is a connectivity issue, and 
you need to troubleshoot the network environment. If the phone does reboot, 
then double-check the dial plan. 

Q. I want to use a different computer to access the administration web server. 
I entered http://SPA9000_ipaddress, but this address did not work.

A. Investigate the following possible causes:

• You may have entered an incorrect address for the SPA9000. To determine the 
correct address, complete the following tasks:

a. Connect an analog phone to an available Phone port on the SPA9000.

b. Press the star (*) key four times: **** 

c. Press 110#. The IP address of the SPA9000 Internet (external) interface is 
announced.

d. If you had the wrong address before, enter the correct IP address in Internet 
Explorer, and proceed. If you had the correct address, then refer to the other 
possible causes in this section.

• WAN access may be disabled. To enable access to the administration web 
server, complete the following tasks:

a. Connect an analog one to an available Phone port on the SPA9000.

b. Press the star (*) key four times: **** 

c. Press 7932#.

d. Press 1# to enable WAN access to the administration web server.

e. Press 1 to save the setting.
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• The SPA900 may be unavailable.

a. Try pinging the IP address of the SPA9000. 

b. If you don’t get a reply, check the connections.

c. Remove the power cord from the SPA9000, wait a short time, and then 
reconnect the power supply to reboot the device.

Q. I configured a SPA932 button to perform call pickup for an extension, but it 
is not working. 

A. Call pickup can be used only in combination with Busy Lamp Field. Your syntax 
must include cp+blf. Review the instructions in “Configuring the SPA932 Sidecar 
to Work with the SPA9000,” on page103.

Q. I’m trying to access the SPA9000 administration web server, but I do not 
see the login screen. Instead, I see a screen saying, “404 Forbidden.”

Complete the following steps:

1. In Internet Explorer, press CTRL + F5 to perform a hard refresh, which forces the 
browser to load new web pages, not cached ones.

2. From the Tools menu, choose Internet Options. Click the Security tab. Click the 
Default level button. Make sure the security level is Medium or lower. Then click 
the OK button.

Q. How do I view the status of my VoIP devices when I can’t access the 
administration web server on the network? 

Complete the following steps:

1. Connect a PC directly to the SPA9000 by connecting a cable from the PC to the 
Ethernet (LAN) port of the SPA9000. 

2. Direct your web browser to the following URL: 
192.168.0.1/admin/router/status

NOTE If you do not get a response, ping the interface to verify that it is 
working, or use IVR option #210 to verify the address on the LAN 
interface. 

3. Click PBX Status to view the status of the devices.
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Q. How do I save my current configuration?

Follow the appropriate procedure, below, for the device that you want to back up:

• SPA9000:

a. Start Internet Explorer, and then enter the IP address of the SPA9000. Click 
Admin Login and then click Advanced.

b. From the menu, choose File > Save As. 

c. Save the configuration as Web Page Complete. You can use the saved file to 
review the saved settings in all pages of the administrative GUI. 

• SPA900 Series Phones:

a. Start Internet Explorer, and then enter the IP address of the phone.

b. From the menu, choose File > Save As. 

c. Save the configuration as Web Page Complete. You can use the saved file to 
review the saved settings in all pages of the telephone configuration. 

• SPA400:

a. Start Internet Explorer, and then enter the IP address of the SPA400. Log on.

b. Navigate to the page that has the settings that you want to save. 

c. From the menu, choose File > Save As. 

d. Save the configuration as Web Page Complete. 

e. Only the currently displayed page is saved. You can use this file to review the 
settings, as needed.

f. Repeat this procedure, as needed, for each page.

Q. How do I debug my SPA? Is there a syslog? 

A. SPA sends out debug information via syslog to a syslog server. The ports can 
be configured (by default the port is 514). Make sure you do not have firewall 
running on your PC that could block port 514. For more information, see the 
SPA9000 Voice System Administration Guide.
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Where to Go From Here

This appendix describes additional resources that are available to help you and 
your customer obtain the full benefits of the SPA9000 Voice System.

• “Product Resources,” on page155

• “Related Documentation,” on page156

Product Resources

Website addresses in this document are listed without http:// in front of the 
address because most current web browsers do not require it. If you use an older 
web browser, you may have to add http:// in front of the web address.

Resource Link

Cisco Partner Central 
(requires partner 
registration and login)

www.cisco.com/web/partners/sell/smb/

Cisco Small Medium 
Business Product 
Information

www.cisco.com/go/smallbiz
SPA9000 Voice System Installation and Configuration Guide for Web UI 155

http://www.cisco.com/web/partners/sell/smb/products/voice_and_conferencing.html#~vc_technical_resources
http://www.cisco.com/go/smallbiz


Where to Go From Here
Related Documentation C

 

Related Documentation

The following table describes the various documents that Cisco provides to help 
you to install, configure, and manage the SPA9000 Voice System and its 
components. 

These documents and more are available at www.cisco.com/go/smallbiz.

Document Title Description Intended Audience

SPA9000 Voice System 
Installation and 
Configuration Guide 
Using the Setup Wizard

Installation, configuration 
and maintenance of the 
SPA9000 Voice System 
by using the Setup 
Wizard.

End Users, VARs, and 
Service Providers

SPA9000 Voice System 
Installation and 
Configuration Guide - 
Web-UI (Legacy) Based 
Product Configuration

Manual installation of the 
SPA9000 Voice System, 
by using the Web User 
Interface, instead of the 
Cisco SPA900 Voice 
System Setup Wizard.

End Users, VARs, and 
Service Providers

SPA9000 Voice System 
Administration Guide

• Administration and 
configuration of system 
features using the 
SPA9000 and SPA400

• Deployment options for 
ITSP, PSTN, and ISDN 
services

• SPA9000, SPA400, 
SPA900 series phones

VARs and Service 
Providers

SPA9x2 Phone 
Administration Guide

• Configuration and 
management of 
SPA9x2 series IP 
phones

• Deployment options 
with or without the 
SPA9000 IP PBX

• SPA9x2 series IP 
phones

VARs and Service 
Providers
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SPA9x2 Phone User 
Guide

• Phone setup

• Phone features

• SPA9x2 series IP 
phones

VARs and phone end-
users

Analog Telephone 
Adapter Administration 
Guide

• Administration and use 
of Cisco Small 
Business ATAs

• PAP2T, SPA2102, 
SPA3102, SPA8000, 
WRP400, and 
WRTP54G

VARs, system 
administrators, and 
Service Providers

User Guide for switch

User Guide for router

Document Title Description Intended Audience
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Additional Information

This appendix provides links to resources that provide additional information 
about Cisco Small Business and Cisco Small Business Pro products and services.

Resource Location

End User License Agreement www.cisco.com/go/smallbiz

Regulatory Compliance and 
Safety Information

www.cisco.com/go/smallbiz

Warranty Information www.cisco.com/go/smallbiz

Cisco Partner Central site for 
Small Business

www.cisco.com/web/partners/sell/smb/

http://www.cisco.com/go/smallbiz
http://www.cisco.com/go/smallbiz
http://www.cisco.com/go/smallbiz
http://www.cisco.com/web/partners/sell/smb/
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Support Contacts

To obtain current support contact information for Cisco Small Business and Small 
Business Pro products, visit the following URL:

www.cisco.com/go/smallbiz 
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